Copyright © 1997
Watlow Anafaze

Information in this manual is subject to change without notice. No part of this publication may be reproduced, stored in a retrieval system, or transmitted in any form without written permission from Watlow Anafaze.

License Agreement and Disclaimer of Warranty:
Read before opening diskette package. By breaking the seal on the disk package, you accept the terms of this license agreement. This software is provided as is and without warranties as to performance. This program is provided without any expressed or implied warranties whatsoever. Because of the diversities of conditions and hardware under which this program may be used, no warranty of fitness for any particular use is offered. The user is advised to test the program thoroughly before relying on it. The user must assume the entire risk of using the program. In no event will Watlow Electric Manufacturing Company or Anafaze, Inc. be held liable for incidental or consequential damages arising out of use of this program.

Warning
This computer program is protected by copyright law and international treaties. Unauthorized reproduction or distribution of this program, or any portion of it, may result in severe civil and criminal penalties, and will be prosecuted to the maximum extent possible under the law.
# CONTENTS

## Overview
- Using this Guide ................................................................. 1
- Online Help ........................................................................... 2
- Watlow Anafaze Technical Support ........................................ 2

## 1 Installation and Setup
- System Requirements .......................................................... 1-1
  - Hardware Requirements .................................................. 1-1
  - Software Requirements .................................................. 1-1
  - Parts List ......................................................................... 1-2
- System Block Diagram ........................................................... 1-2
- Safety .................................................................................. 1-2
- Installation ........................................................................... 1-3
- System Setup ....................................................................... 1-3
  - Setting the Controller to ModBus Protocol ......................... 1-4
  - Configuring your Controllers ........................................... 1-4
  - Channel Grouping ........................................................... 1-6
  - Other Configuration Options ............................................. 1-7
- Monitoring the Configured Controllers ............................... 1-10

## 2 AnaWin Screen Displays
- Screen Conventions ............................................................ 2-1
- Main Menu ......................................................................... 2-3

## 3 Exporting Data
- Export Database ................................................................. 3-1
- Data Log Setup ................................................................. 3-4

## 4 Setting System Parameters
- Login .............................................................................. 4-2
- Logout .............................................................................. 4-2
- Preferences ....................................................................... 4-2
  - Normal Startup .............................................................. 4-3
## 5 Setting Channel Parameters

- Channel Parameters .................................................. 5-1
- Channel Summary ...................................................... 5-2
- Real-time Trend Plot .................................................. 5-3
- Channel Setup Tabs .................................................... 5-4
- Ramp Soak Setup ....................................................... 5-7
- Assigning Profiles to Loops ....................................... 5-8
- Using Special Ramp-Soak Functions .......................... 5-9
- Editing Profiles .......................................................... 5-12

## 6 Managing Recipes

- New .............................................................................. 6-2
- Open ............................................................................. 6-3
- Save ............................................................................. 6-3
- Save As ........................................................................ 6-3
- Remove ........................................................................ 6-4
- Download ..................................................................... 6-4
- Calendar ....................................................................... 6-4
- Recipe Start ................................................................. 6-5
- Monthly Calendar ....................................................... 6-6
- Scheduled Recipes ...................................................... 6-6
- Suspend Calendar Events ........................................... 6-6

## 7 Using the Trend Plot Screen

- Trend Plot ..................................................................... 7-1
- Trend Plot Screen Features ........................................ 7-2
- Toolbar ......................................................................... 7-8
- Trend Plot Settings ..................................................... 7-20
  - Data Sets .................................................................. 7-20
  - Graphing Limits ...................................................... 7-21
Time Range ................................................................. 7-21
Trend Plot Storage .................................................. 7-21
Disk Space Analysis .............................................. 7-22
Recording Rate ...................................................... 7-22
Maximum Days Stored on Disk ......................... 7-22

8 Viewing Channels

Spreadsheet ............................................................. 8-1
Bar Graph Display ............................................... 8-2
Gauge Display ...................................................... 8-2
Digital I/O ................................................................. 8-4
  Inputs ................................................................. 8-4
  Outputs .............................................................. 8-4
Overview Thumbnails .......................................... 8-5
Custom Overview Screens ................................. 8-6

9 Working with Log Files

View (Logs) .............................................................. 9-1
  Log File ............................................................. 9-2
  Time of Event .................................................... 9-2
  Event Numbers ............................................... 9-2
  Event Description ............................................ 9-3
  Search ............................................................... 9-4
Print ................................................................. 9-4
Copy to A: .............................................................. 9-4
Remove (Logs) ....................................................... 9-4
Closing a Log ......................................................... 9-4

10 Using the Developer

Using the Developer Program .......................... 10-1
  Design Custom Overview ................................. 10-3
  User Variables .................................................. 10-20

11 Working with System Alarms

Interpreting the Alarm Screen ......................... 11-1
  Date/Time ......................................................... 11-2
  Group Name ....................................................... 11-2
  Channel Name .................................................. 11-2
  Alarm Message .................................................. 11-2
Overview

This guide describes how to install, set up, and operate AnaWin. AnaWin32 is Windows®95 software that allows you to program and monitor one or more controllers from a single PC. AnaWin allows you to log data to disk, graph data, schedule automatic recipe changes, manage alarms, manage recipes, configure control parameters, create custom overview screens, and use the advanced control features of your Watlow Anafaze controller through a graphical user interface.

Using this Guide

This guide is intended for both experienced and inexperienced users. If you are an experienced user, you may want to skim parts of this guide. If you are an inexperienced user, you should read the entire guide carefully. We assume that AnaWin users have a basic knowledge of Windows95.

The information in this guide is organized into the following chapters.

- **Chapter 1, Installation and Setup:** Describes how to install AnaWin and how to use the Configuration program to connect to one or more controllers, create loop/channel groups, and customize channel, parameter, and I/O names.
- **Chapter 2, AnaWin Screen Displays:** Describes basic screen conventions and how to navigate the main menu.
- **Chapter 3, Exporting Data:** Describes how to export data from AnaWin to other applications, including how to specify when data is logged and which channels are included in the log file.
Overview

- **Chapter 4, Setting System Parameters**: Describes how to use the system menu, to set preferences and configure AnaWin to operate with your controller.

- **Chapter 5, Setting Channel Parameters**: Describes how to use the Channel Setup screen to configure a controller.

- **Chapter 6, Managing Recipes**: Describes the Recipe menu, and how to create, store and use recipes through AnaWin.

- **Chapter 7, Using the Trend Plot Screen**: Describes AnaWin’s trend plotting features.

- **Chapter 8, Viewing Channels**: Describes different ways of viewing system data in AnaWin.

- **Chapter 9, Working with Log Files**: Describes event logs and how to view them.

- **Chapter 10, Using the Developer**: Describes how to design and use custom overview screens and how to define user variables.

- **Chapter 11, Working with System Alarms**: Describes the AnaWin Alarm screen and how to acknowledge alarms.

- **Appendix A, Using AnaMator**: Describes how to use the AnaMator application to create animations which you can add to your AnaWin custom overview screens.

- **Appendix B, User Variable Operators and Functions**: Lists the operators and functions that may be used in the user variables spreadsheet.

- **Appendix C, AnaWin OLE Server**: Describes OLE (Object Linking and Embedding), which is used in the interchange of data with other Windows95 applications.

**Online Help**

AnaWin provides a comprehensive Help system which you can access from the Help menu, or by pressing F1. Pressing F1 provides context-sensitive help related to the part of the software that is displayed at the time.

**Watlow Anafaze Technical Support**

We have made every effort to ensure that you will be able to install, set up and maintain AnaWin using the information in this guide and in the online help. Should you need further assistance, call Watlow technical support.
Installation and Setup

This chapter describes how to install AnaWin on your computer and how to use the Configuration program to set up AnaWin to communicate with your controller(s).

System Requirements

The following components are required to operate AnaWin.

Hardware Requirements

- Pentium 100MHz or greater with a minimum of 16M B of RAM (Pentium 133 with 32 M B recommended for animation)
- Hard drive with 20M B of free space (500 M B is recommended for logging and trending)
- 3.5 inch HD floppy drive
- SVGA display (high-color recommended)
- Communications port capable of 19.2 K baud (with 16550 UART)
- Microsoft®-compatible sound card (recommended for voice-annunciated and customized alarm sounds, but not required)
- Microsoft-compatible pointing device (mouse or trackball)

Software Requirements

- Windows95 or WindowsNT 4.0
Parts List

The following parts are included with AnaWin:

- AnaWin on 3.5 inch diskettes.
- AnaWin User’s Guide

System Block Diagram

Figure 1-1 shows how a PC (using AnaWin) interfaces with one, or more, controllers.

Communication to a single controller can be made using an RS-232 connection to one of the PC’s serial ports.

The serial communication link required to communicate with more than one Watlow Anafaze controller or with a communication cable longer than 50 feet is RS-485. We recommend using the standard serial interface of RS-232 with an external RS-485 converter.

We recommend using a B&B Electronics RS-232/RS-485 optically isolated converter P/N 485OIC. This converter has screw terminals for connecting the RS-485 wires and a DB-25 Male connector for the RS-232 side. You can reach B&B Electronics at (815) 434-0846.

Contact the factory for other available converters.

Safety

While Watlow Anafaze has made every effort to ensure the reliability and safety of its controllers and AnaWin, AnaWin—like any other application—can fail, and other unexpected conditions can occur.
Good engineering practices, electrical codes, and insurance regulations require you to use independent external safety devices to prevent potentially dangerous or unsafe conditions. Use of AnaWin does not eliminate the need for appropriate external, independent safety devices.

For additional process safety, use AnaWin to automatically reload your desired operating parameters after a power failure.

Please contact Watlow Anafaze immediately if you have questions about system safety.

Installation

To install AnaWin, follow these steps:
1. Click on the Windows95 Task Bar with the right mouse button, then choose Properties, then Autohide.
2. Insert the disk labeled AnaWin Disk 1 in the floppy drive.
3. Click on Start and Run at the bottom of the screen.
4. Type a:\setup or b:\setup.
5. The Setup program prompts you through the installation process. Follow the instructions on the screen.
   The first time you run AnaWin, you are prompted to enter your serial number. You must enter the serial number printed on AnaWin disk 1. You will also need this serial number any time you request technical support.

AnaWin loads the Configuration program and displays the controller setup screen. Refer to “System Setup,” below, for instructions on using the controller setup screen.

System Setup

The controller setup screen, shown in Figure 1-2, allows you to set the software parameters to match the controller(s). When you first install AnaWin, this screen appears automatically after a successful install. If AnaWin has been previously installed, you can access the controller setup screen by selecting Configure from the System menu.
Setting the Controller to ModBus Protocol

Before configuring the software, set your controller(s) to ModBus Protocol. Do this using the controller keypad and display shown in Figure 1-3. Select the Global Parameters menu and set the Communication Protocol screen to MOD, as show in the figure. Set a unique address in each controller. Refer to your controller manual for more detailed instructions.

Configuring your Controllers

To configure AnaWin to communicate with your controller(s), follow these steps:

1. On the Controller Setup screen set the total number of controllers, with which AnaWin must communicate.

   Number of CLS / MLS Controllers: 1

2. Set the series number of the first controller you wish to configure.

   Current CLS / MLS Number: 1
3. Choose the controller type and model. AnaWin automatically sets the number of channels based on this data.

4. Set the ModBus address for the controller. Note that each controller must have a unique ModBus address.

```
NOTE
You can use the Detect button to automatically set up each ModBus address, but this operation takes considerable time to complete. Refer to “Other Configuration Options” later in this chapter for details about the Detect button.
```

5. If the controller is equipped for ramp/soak, select the Ramp Soak Option check box.

6. Ensure the Comm Status of the controller has been set to Online. Set a controller Off-line to speed up communications when you remove the controller from the system or at other times when it cannot communicate.

```
NOTE
When changing the number of controllers or controller type, AnaWin will automatically restart itself when the information is saved.
```
Channel Grouping

Select Channel Grouping from the System menu to display the Channel Grouping setup screen, shown in Figure 1-4. This screen allows you to set up channel groups. Select Allow Channel Grouping in order to allow channel grouping.

When channels are grouped, the spreadsheet view shows only one group of channels at a time. Recipes and recipe management are also group-specific—each group has its own set of recipes.

NOTE
Setting up channel groups deletes pre-existing recipes and logged data. Group channels only if you want separate recipe control for certain channels.

By default, AnaWin creates one group with all the controllers' loops. To separate channels into defined groups, follow these steps:

1. Select Allow Channel Grouping.
2. Select the Default group in the Group Name field.
3. Click Delete to delete the Default group.
4. Click New and enter a Name for the new group.
5. Select a Controller in the Available panel.
6. Use the Start channel and End Channel fields to define a sequence of channels to be included in the group.
7. Click Add to add the specified channels for the selected controller to the group. The channels you add are listed in the group panel.
8. Repeat steps 4-7 to create additional groups until you have put all the channels into a group. Any channels that you do not put in a group will not be available in AnaWin.

NOTE
A group must consist of contiguous sets of loops from within any one controller, though it may contain sets of contiguous sets of loops from several controllers.

Allow Channel Grouping

You must select the Allow Channel Grouping option in order to be able to group channels. With channel grouping, you can establish related blocks of channels for display and editing purposes. These groups can cross more than one controller, but must be in sequence. For instance, one group might include channels 1 to 10, and another, channels 11 to 16 etc. But you would not be able to have a group that included channels 2, 5, 6, 7, and 9, because they are not all in sequence.
FIGURE 1-4 Channel Grouping Setup Screen

Group Parameters

- **Name**: Displays the name of the group currently selected in the list.
- **New**: Lets you create a new group to add to the list.
- **Rename**: Lets you rename a group.
- **Delete**: Lets you delete a group.

Add and Remove Buttons

These buttons allow you to add channels to and remove channels from a group.

**Add**: Lets you add the sequence of channels defined by the *Start Channel* and *End Channel* fields to the current group.

**Remove**: Lets you remove the channels selected in the list in the Group panel from the current group.

Available Controllers and Channels

The Available panel allows you to select a controller and block of channels for grouping. The *Start Channel* and *End Channel* fields define the sequence of channels to add to the group. Click **Add** to add these channels to the group. When you add a sequence of channels, the channel names are listed in the Group panel.

Other Configuration Options

You can perform the following optional configuration options.

- Automatically set up each ModBus address.
- Configure communications options.
- Customize displayed parameter, channel, and/or digital I/O names.
The following subsections describe these options.

**Automatic ModBus Address Setup**

Click *Detect* to direct AnaWin to automatically attempt to communicate to each ModBus address. AnaWin checks each address and sets up any controllers it finds.

**Configuring Communications Options**

Use the *Communications* option on the *System* menu to select the port to which you have connected your controller(s) and the baud rate for which you have configured your controller(s).

- From the *System* menu, select *Communications*, then *Port* to select the port to which you have connected the controller(s).
- From the *System* menu, select *Communications*, then *Baud Rate* to select the baud rate for which you have configured your controller(s).

**Customizing Displayed Names**

Use the options on the *Names* menu to customize displayed names of specific global and channel parameters or names of channels and digital inputs and outputs.

From the *Names* menu, select *Parameter Names* to display the Parameter Names screen, shown in Figure 1-5. Use this screen to customize channel, global, and ramp/soak parameter names.

![Parameter Names Screen](image_url)

**FIGURE 1-5** Parameter Names Screen
To customize parameter names follow these steps:

1. Use the Parameter Type radio buttons to select a group of parameters to rename (Channel, Global, or Ramp Soak).
2. Use the Parameter pull-down list box to choose the first parameter of the selected type that you want to rename.
3. Enter your custom name in the Display Name field.
4. Repeat steps 2 and 3 for the other parameters of the selected type that you want to rename.
5. If desired, repeat steps 1-5 to rename parameters of a different type.

**NOTE**

The Data Table Ref field on the Parameter Names screen is a read-only field that refers to the CLS Data Table. Refer to the Communications Specifications manual for details.

- From the Names menu, select Channels & DIO, to display the Channel and Digital IO Names screen, shown in Figure 1-6. Use this screen to customize channel and digital input and output names.

![Channel and Digital IO Names Screen](image)

**FIGURE 1-6** Channel and Digital IO Names Screen

Use the Channel Names panel to customize channel names. One by one, select the channels you want to rename from the Channel pull-down list box, then enter your custom name in the Name field.

Use the Digital IO Names panel to customize digital input and output names. One by one, select the input or output you want to rename from the Input or Output pull-down list box, then enter your custom name in the Name field.
Monitoring the Configured Controllers

Once you have used the Configure program to configure your controllers, select Return from the File menu to return to AnaWin and begin monitoring the controllers you have configured, as described in the remaining chapters of this guide.
This chapter describes the features common to most AnaWin screens and lists the options available from the AnaWin main menu bar.

**Screen Conventions**

Figure 2-1 shows a typical AnaWin screen.

**FIGURE 2-1** AnaWin Screen Conventions
The following standard features appear on most AnaWin screens:

**Caption:** The name of the current screen.

**Main Menu:** Displays the AnaWin menus. Refer to “Main Menu,” later in this chapter for a diagram of the menu options on the main menu.

**Last Recipe Downloaded:** Displays the name of the last recipe downloaded to the controller.

**Current Group:** The name of the group currently selected for display. Refer to “Channel Grouping,” in Chapter 1 for details about creating channel groups.

**Login Button:** Click *Login* to identify yourself to AnaWin. Refer to “Login,” in Chapter 4, for details.

**Logout Button:** Click *Logout* to ensure unauthorized personnel are not able to access AnaWin features without logging in. Refer to “Logout,” in Chapter 4, for details.

**Alarm Button:** Click *Alarm* to display the Alarm screen. The color of the *Alarm* button also serves as an alarm indicator:

- Green = No alarms
- Yellow = Channel in deviation
- Red = Channel in alarm

Refer to Chapter 11 for details about viewing and acknowledging alarms.

**Cursor/Location Description:** Displays a description of the current cursor location or current operation.

**Communicating Controller:** Indicates the controller with which AnaWin is currently communicating.

**Communication Status Indicator:** Displays the current communication status. The communication status is indicated both by the text on this bar and the color of the bar:

- Green = Communicating
- Red = Not communicating
- Yellow = Incomplete communication: AnaWin is communicating with some, but not all, of the controllers for which it has been configured. This status occurs if one or more controllers is set offline or a communication has failed with one or more controllers.
**Time:** Displays the current time.

**Maximize/Minimize:** Click the *Minimize* and *Maximize* buttons to minimize and maximize the screen.

### Main Menu

You use the main menu to access AnaWin screens and to perform basic operations with the controller. Figure 2-2 shows the options available from the main menu. The following chapters describe the features available from the menus.

![Main Menu Diagram](image-url)

**FIGURE 2-2 AnaWin Main Menu Options**
Exporting Data

This chapter explains how to use the data export features on AnaWin’s File menu. While AnaWin provides comprehensive trend plotting capabilities, you may need to export data to other applications. Two options are available for exporting: Export Database and Data Log Setup.

Using the Export Database and Data Log Setup options, you can customize when data is logged and which channels are included in the log file. You can then use these data logs with programs other than AnaWin to report or analyze your process performance or history. You might, for example, import data into a spreadsheet application and graph it for a report.

Export Database

Select Export Database to display the Export Settings screen, shown in Figure 3-1. From this screen, you can export a block of process data into a text file. This option is a one-time export of data, based on a block of time and channels you set from data accumulated for trend plotting.
FIGURE 3-1 Export Settings Screen

Setpoint, process variable, and heat and cool output power are logged whenever AnaWin communicates with one or more controllers. The maximum sampling frequency is determined by the parameters set through the Trend Plot menu. Refer to “Trend Plot Settings.” in Chapter 7, for information on how to set the frequency for data collection.

Set the following parameters on the Export Settings screen to set up export to a database file.

Begin Report

Use the Begin Report fields to define the time (Hours, minutes, seconds) and the day (day, month, year) serving as the starting point of your data log file. The time is in 24-hour format.

To change a value, either overtype the existing value using the keyboard or move the cursor to the left of the value you want to change and click on the up/down arrows to increase or decrease the values.

End Report

Use the End Report fields to define the time (Hours, minutes, seconds) and the day (day, month, year) serving as the ending point of your data log file.

Click on the up/down arrows to the right of the value you want to change, and to increase or decrease the values.

Now

If you want your data logging file to end at the current moment, click Now instead of using the up/down arrows.
Exporting Data

Logging interval

The logging interval is the span of time (in seconds) for the data points to be exported. The default value is 5, meaning that exported data represents the state of the process variables every five seconds between the starting and ending points. Increase or decrease the Logging Interval by entering a new value and pressing Enter. If you do not press Enter, the old value will re-appear.

Export file

The Export File field lists the file name for the default text file. The default file name consists of the date, expressed in 6 figures, and the suffix TXT.

Select File

Click the Select button to set the name and location of the file to be created when data is exported. The data you have selected is saved in the file you indicate. Figure 3-2 shows a sample exported data file.

Select Channels to Export

The data export file can include all the channels in the system, or only some of them, according to your needs. Use the Select Channels button in the Select Channels to Export panel, to select the channels you wish to export.

Press the Select Channels button to select the channels you wish to export.
The Select Channels to Export panel lists the total number of channels in the system and the total number of channels currently selected for export. Click Select Channels to select specific channels from the total. Select the channels you wish to export, then click OK.

**Export Data Now**

Click Export Data Now to export data to the selected text file using the specified export settings.

**Data Log Setup**

Select Data Log Setup to display the Data Log Settings screen, shown in Figure 3-3. From this screen, you can set AnaWin to regularly log data to a database file.

**Data Logging Status**

The data logging status (ON or OFF) appears at the top of the screen. If the data logging status is OFF, no continuous data logging will occur. Set the data logging status to ON, to begin continuous logging.

**Logging Interval**

Set the frequency of data logging. Setpoint, process variable, and two output variables for each selected channel are logged according to the period defined in this field.

**Select Channels to Log**

The data logging file can include all the channels in the system, or only some of them, according to your needs. Use this field to select the channels you want to log.
Start
Click *Start* to begin data logging.

Stop
Click *Stop* to end data logging.

Done
Click *Done* to leave the screen with no changes.
Exporting Data
Setting System Parameters

This chapter explains how to use the options on the System menu to set preferences and configure AnaWin to operate controller(s). If password protection has been enabled, you can also access login and logout screens.

The System menu includes the following options:

- Login
- Logout
- Preferences
- Com Enabled
- Com Diags
- Configure

AnaWin provides numerous customizable features which can help you adapt the program to work in a way that fits your needs. You can establish intelligent connections between your process and your AnaWin interface by:

- Enabling and configuring password protection to help ensure each user is only presented with the screens and commands he or she has been trained to use.
- Setting startup preferences that allow AnaWin to bring up your process appropriately after a normal shutdown and differently after a power failure.
- Customizing how the interface reacts when an alarm occurs.
- Customizing the comment prompt displayed when a recipe is saved.
- Configuring a digital input or output to prevent recipe downloading.
Login

Select Login to display the User Login screen, shown in Figure 4-1. This screen allows you to log in to the system or identify yourself to AnaWin. Note that the User Login screen appears only if Enable Passwords is selected on the Preferences screen. Refer to "Preferences," later in this chapter, for details.

![User Login Screen](image)

FIGURE 4-1 User Login Screen

Select your Level and type your Password. Refer to “Setup Passwords,” later in this chapter, for details.

Logout

Select Logout to log out of the system.

Preferences

Select Preferences to display the Preferences screen, shown in Figure 4-2. This screen allows you to set startup options and other AnaWin operational parameters. These settings allow you to customize AnaWin’s features.

![Preferences Screen](image)

FIGURE 4-2 Preferences Screen
Normal Startup

The Normal Startup panel, shown in Figure 4-3, allows you to specify what actions will occur when you launch AnaWin.

![Normal Startup Panel](image)

**Normal Startup**

<table>
<thead>
<tr>
<th>Action</th>
<th>Read Parameters From Controller</th>
</tr>
</thead>
</table>

**FIGURE 4-3** Normal Startup Panel on Preferences Screen

You can set one of these three Actions:

- **Read Parameters From Controller**: Reads the operational parameters from the controller on bootup.

- **Send Parameters to Controller**: Downloads parameters from AnaWin to the controller(s). If you select this option, you can either have AnaWin load the last recipe which was downloaded or any of the recipes saved on the PC’s hard disk.

- **Operator Select on Startup**: Prompts the operator to choose to read parameters from the controller or download a recipe when AnaWin is launched.

Power Fail Recovery

The Power Failure Recovery panel, shown in Figure 4-4, allows you to specify how AnaWin will respond after a sudden loss of power. Set a time limit and appropriate startup actions. If AnaWin is launched within the time limit, it executes the **Under Limit Action**. If AnaWin is launched after the time limit elapses, it executes the **Over Limit Action**.

![Power Failure Recovery Panel](image)

**Power Failure Recovery**

| Time Limit | 0 hrs 5 min |

**Under Limit Action**

| Read Parameters From Controller |

**Over Limit Action**

| Read Parameters From Controller |
Under Limit Action: Sets a startup operation if the amount of time AnaWin is powered down is less than the specified time limit.

Over Limit Action: Sets a startup operation if the amount of time AnaWin is powered down is greater than the specified time limit.

You can choose from three options for the under and over limit actions:

- **Read Parameters From Controller**: Reads the operational parameters from the controller on bootup.
- **Send Parameters to Controller**: Downloads parameters from AnaWin to the controller(s). If you select this option, you can either have AnaWin load the last recipe which was downloaded or any of the recipes saved on the PC’s hard disk.
- **Operator Select on Startup**: Prompts the operator to choose to read parameters from the controller or download a recipe when AnaWin is launched.

**Save**

Click **Save** to save the Program Startup options you have set. Changes made to other portions of the Preferences screen are saved immediately when you make the changes.

**Cancel**

Click **Cancel** to cancel changes in the Program Startup panel.

**NOTE**

When using channel grouping, set options in the Program Startup panel for each group.

**Miscellaneous System Parameters**

Figure 4-5 shows the miscellaneous system parameters available on the Preferences screen. The following subsections describe these parameters.

![Miscellaneous Parameters](image)

**FIGURE 4-5** Miscellaneous Parameters on the Preferences Screen
Computer Audible Alarm

Sets the computer's audible alarm to respond when an alarm condition occurs.

Auto Alarm View

Sets the alarm screen to appear automatically any time an alarm occurs.

Enable Passwords

Turns on password protection and enables the Setup Passwords button. Refer to “Setup Passwords” later in this chapter for details about setting up passwords.

Allow Windows Screen Saver

Normally, AnaWin disables the Windows screen saver. Select this option to allow a Windows screen saver to run.

Setup Passwords

Use password protection to limit access to certain menus and screens. To enable password protection, select the Enable Passwords check box on the Preferences screen (AnaWin is shipped with passwords disabled.) Click Setup Passwords to display the Password Setup screen, shown in Figure 4-6. Note that you must have Supervisor rights to access the Password Setup screen. A default password has been assigned to each password level.

NOTE

The default password is control (all lower-case letters).

![FIGURE 4-6 Password Setup Screen]
You can set password protection by user Level (operator, supervisor, engineer, or none), or by specific User.

- **Level**: Select Level to divide password protection between Operator, Engineer, Supervisor, or None user levels.
- **User**: Select User to set up passwords for users by name. If you select the User option, you must assign a user level and password to each user. Do this in the User Information section of the screen as described under “Setting Passwords by Level,” later in this chapter.

**NOTE**
If you misplace or forget the Supervisor password, call Technical Support for a one-day only master password.

### Setting Passwords by Level

If you select the Level option, you can set three passwords: Operator, Engineer, or Supervisor. You can set access for each level in the Password Level Required panel, as described below.

**Password Level Required**: The Password Level Required panel, shown in Figure 4-7, allows you to assign access rights for user levels to portions of AnaWin.

![Password Level Required Panel](image)

**FIGURE 4-7** Password Level Required Panel

When you double-click All Menus, the AnaWin menu tree appears as shown in Figure 4-8. Select the portions of the menu tree to password protect. To enable password protection, highlight a menu item and click the button corresponding to the user level. The None designator changes to the selected user level.
Setting System Parameters

AnaWin User’s Guide 4-7

FIGURE 4-8 AnaWin Menu Tree with Assigned User Levels

**Level Passwords:** The Level Passwords panel, shown in Figure 4-9 allows you to set the passwords for the three user levels.

![Level Passwords Panel](image)

**Setting Passwords by User**

If you select the *User* option, the user information panel, shown in Figure 4-10, appears on the Password Setup screen, and you can assign a password and security level to each user. *User* security mode allows you to assign each user a unique password. In user security mode, the Administrator user is always present. Change the default password to prevent unauthorized access.

![User Information Panel](image)

AnaWin User’s Guide 4-7
To add a user, follow these steps:
1. Enter the user’s name in the User Name field.
2. Enter a password for that user in the Password field.
3. Use the Level pull-down list box to select a security level for that user.
4. Click Add User. The user’s name now appears in the list under the User Name field.

To delete a user, follow these steps:
1. Select the user’s name from the list under the User Name field.
2. Click Delete User.

To change a user’s password or security level, follow these steps:
1. Select the user’s name from the list under the User Name field.
2. Enter a new Password and/or select a new security Level.
3. Click Modify User.

**Default Recipe Comment**

The Default Recipe Comment field allows you to edit the default recipe comment text. To change the text of the default comment, shown in Figure 4-11, use the keyboard to delete and add text. Note that any changes you make will appear in the comment section when a new recipe is saved.

<table>
<thead>
<tr>
<th>Default Recipe Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Created By:</td>
</tr>
<tr>
<td>Rev Date:</td>
</tr>
<tr>
<td>Purpose:</td>
</tr>
<tr>
<td>Comments:</td>
</tr>
</tbody>
</table>

**FIGURE 4-11** Text for Default Recipe Comment
Disable Recipe Download

Select Disable Recipe Download and set the associated options, shown in Figure 4-12, to set the software to prevent recipe downloads under the specified conditions.

![DISABLE RECIPE DOWNLOAD OPTIONS](image)

Select a digital input or output and state (high or low), as the condition that will prevent recipe downloads.

Gauge Display Editable Parameters

Use the Gauge Display Editable Parameters panel, shown in Figure 4-13, to specify which parameters on the Gauge Display screen are editable. Place a check mark in the box corresponding to each parameter you want to be editable.

![GAUGE DISPLAY EDITABLE PARAMETERS PANEL](image)

Communications

From the System menu, select Communications, then Enabled or Disabled to enable or disable communications with one or more of the controllers.

When you select Enabled or Disabled, a selection window appears. From this window, select the controller for which you want to enable or disable communications, then click OK.

When communication is enabled, the indicator shown in Figure 4-14 appears in the bottom right-hand portion of the screen. This indicates that AnaWin is communicating with the controller(s).
When communication is disabled or communication with all controllers has failed, the indicator shown in Figure 4-15 appears on the bottom right-hand portion of the screen. This indicates that AnaWin is not communicating with the controller(s).

**FIGURE 4-15 Communication Disabled Indicator**

When AnaWin is set up to communicate with multiple controllers, and some controllers are not communicating, the indicator displays “INCOMPLETE COMM”.

### Com Diags

Select Com Diags to display the Communication Diagnostics screen, shown in Figure 4-16. This screen displays the cumulative communications errors encountered within the specified time limit. Use the Evaluation Time Window field to set the time limit.

**FIGURE 4-16 Communication Diagnostics Screen**

### Configure

Select Configure to leave AnaWin and launch the Configure program. Refer to the Chapter 1 for details about using the Configure program.

### Snapshot

Select Snapshot to save or restore a snapshot of a selected controller’s settings. A snapshot is a backup of the controller’s data table. When snapshot save is selected, the entire data table is read and stored on the computer’s hard disk. Restoring a snapshot puts a controller back to a previously saved state which is especially useful after a controller firmware update or when a controller is replaced.
Save

Select Snapshot, then Save to select the controller for which you want to save a snapshot. You can save one snapshot for each controller. Select the desired controller, then click OK to save a snapshot of the controller’s current settings—including any changes you have made in the current session.

Restore

Select Snapshot, then Restore to restore a snapshot. Select the desired controller, then click OK to restore the snapshot of the controller’s settings before you made any changes.
Setting System Parameters
This chapter explains how to use the options on the Channel Setup menu to configure channel parameters and set up ramp soak options. The Channel Setup menu includes the following options:

- Channel Parameters
- Ramp Soak Setup

The channel parameter and ramp/soak screens simplify and streamline the task of setting up your controllers. The channel copy feature, for example, can save you literally hours of tedious data entry. Graphical displays group related parameters and present them more clearly than is possible on the controller front panel interface.

Channel Parameters

Select Channel Parameters to display the Channel Setup screen, shown in Figure 5-1. Use this screen to set the input, output, control, and alarm parameters for each channel. The Channel Setup screen also includes a real-time plot screen that displays the process variable and output variable as you make changes.
Channel Summary

The top portion of the Channel Setup screen, shown in Figure 5-2, allows you to choose a channel to set up and provides some basic information about the channel being edited.

**Channel Number**

Use the channel number pull-down list box to choose the channel you want to edit or view.

**Setpoint**

Use the Setpoint field to enter a setpoint for the selected loop. The setpoint range appears at the bottom of the screen when you position the cursor over the field. If you enter a setpoint that is out of the defined range, the controller will assign the closest number within the range. Press the Enter key to send your new setpoint to the controller.

**Process**

The Process field displays the process variable in real time. It is a read only field.
NOTE
If Allow Channel Grouping is selected on the Controller Setup screen, only the channels assigned to the current group will be available for selection.

Copy to channels

Click Copy to Channels to copy the displayed channel's setup to another channel. This feature enables fast and easy channel setup. You cannot copy the setup of a pulse channel to a non-pulse channel, and vice versa.

When you click Copy to Channels, the channel list shown in Figure 5-3 appears. Highlight the desired channel(s), then click OK. The parameters from the current channel are copied to each of the selected channels.

FIGURE 5-3 Selecting Channels to which to Copy Parameters

Control Mode and Ramp/Soak Status

The right side of the Channel Setup screen's channel summary area displays the control modes Manual, Auto, or Tune. Use the Control tab in the Channel Setup Tabs panel to change the control mode. Refer to “Control,” under “Channel Setup Tabs,” for details. If Manual mode is selected, you can use the Heat PID and Cool PID fields to change the power percentages; otherwise, if a ramp/soak profile is assigned to the channel, the ramp/soak status—Start, Run, or Hold—is displayed. Refer to “Control,” under “Channel Setup Tabs,” for details about how to set the ramp/soak status.

Real-time Trend Plot

The real-time trend plot on the right of the Channel Setup screen provides real-time graphic trending.
The trend plot displays the last five minutes of the process for the current channel. Three parameters are plotted: Process Variable (PV), Output Value (OV), and Setpoint (SP).

The real-time trend plot screen is not editable. You cannot change the parameters being plotted (PV, OV, SP) or change the time frame of the graph. Use the plot for a quick view of your process, and as an aid when tuning your control process.

**In:** Increases the plot’s vertical axis resolution.

**Out:** Decreases the plot’s vertical axis resolution.

**Last:** Returns the plot to the last vertical axis scaling values.

**Scale:** Scales the trend plot to fit into the size of the plot window.

### Channel Setup Tabs

The Channel Setup screen contains five tabs, shown in Figure 5-4, that allow you to set the parameters for the channels. Refer to your controller manual for setup information.

![Channel Setup Tabs](image)

**FIGURE 5-4 Channel Setup Tabs**

**Input**

Use the Input tab, shown in Figure 5-5, to choose the sensor type and other input parameters.

![Channel Setup Input Tab](image)

**FIGURE 5-5 Channel Setup Input Tab**

When you choose Skip, you cannot edit any of the parameters.

When you choose Linear or Pulse as the input type, the four Sensor Reading Range Settings fields become available.
Output

Use the Output tab, shown in Figure 5-6, to enable or disable outputs and to choose the output signal type.

![Channel Setup Output Tab](image)

**FIGURE 5-6** Channel Setup Output Tab

The Output tab includes two panels: one for output #1 (generally for heat) and one for output #2 (generally for cool). When you select Time Proportioning output, another field appears in which you can enter the cycle time for the TP output. If you select SDAC output, the SDAC Settings panel, shown in Figure 5-7, appears.

![SDAC Settings Panel](image)

**FIGURE 5-7** SDAC Settings Panel

Control

Use the Control tab, shown in Figure 5-8, to select a control mode (Auto, Manual, or Tune) or the ramp/soak status (Start, Run, or Hold). The mode or status you select here appears in the upper part of the Channel Setup screen, in the channel summary area, as described in this chapter.
In addition, the Control tab also includes the following fields that allow you to set control parameters for output #1 and output #2:

**Prop Band:** The range in which the proportioning function of the control is active.

**Integral:** A control action that automatically eliminates offset, or droop, between setpoint and actual process temperature.

**Derivative:** A control action that anticipates the rate of change of the process and compensates to minimize overshoot and undershoot. This value is measured in seconds.

**PID Filter:** The time constant for the output filter. The heat or cool output filter prevents oscillations by dampening the output’s response. The output responds to a step change by going approximately 2/3 of its final value within the number of scans that are set.

For loops with a ramp/soak profile assigned, the following information is displayed:

**Tim Rem:** Time remaining for the profile.

**Total Time:** Time the profile has been running.

**Seg Time:** Time remaining in the current segment.

**Cycle:** Cycle number; the cycle’s number out of the total cycles. Refer to “Ramp Soak Setup,” later in this chapter, for further details about the ramp/soak feature.

**Alarm**

Use the Alarm tab, shown in Figure 5-9, to enable alarms, set alarm limits and alarm delays, customize alarm messages, and assign digital outputs to alarms.
Other

Use the Other tab, shown in Figure 5-10, to edit additional output parameters.

Ramp Soak Setup

AnaWin’s ramp/soak feature turns your controller into a powerful and flexible batch controller, which you can program to change a process’ setpoint in a preset pattern over time. This pattern, or temperature profile, consists of up to twenty segments. During a segment, the temperature goes from the previous segment’s setpoint to the current segment’s setpoint.

- If the current segment’s setpoint is larger or smaller than the previous segment’s setpoint, the segment is called a ramp.
- If the current segment’s setpoint is the same as the previous segment’s setpoint, the segment is called a soak.
Each segment can have up to two triggers (digital inputs). If enabled, these triggers must be true before the segment can start. When neither of the triggers is true, the profile is in the trigger wait state. You can use the same trigger for more than one loop or one profile.

Using AnaWin’s ramp/soak feature, you can:
- Assign new ramp/soak profiles.
- Synchronize loops.
- Modify segment times.
- View and modify profiles.
- Save profiles to disk.

Your controllers must include the ramp/soak option in order to use AnaWin’s ramp/soak feature. In addition, you must enable ramp/soak in the Configuration program—by selecting the Ramp Soak Option check box on the Controller Setup screen—in order to activate the ramp/soak screens. If you do not select this option, the ramp/soak screens will not be available.

**Assigning Profiles to Loops**

Select Ramp Soak Setup from the Channel Setup menu to display the Ramp Soak Assignment screen, shown in Figure 5-11. From this screen, you assign profiles to loops.

NOTE
If you do not have any ramp/soak controllers connected to your system, you will get an error message when you select Ramp Soak Setup.

The Ramp Soak Assignment screen consists of a table in which each row corresponds to a channel.
Location

Use the Location column to select a memory location in the controller to which to download a profile.

Profile Name

The Profile Name column indicates whether or not a profile has been assigned to the corresponding channel.

If the Profile Name button is blank, clicking the column displays the Select File window, shown in Figure 5-12. Use this window to assign a profile to the loop.

To assign a new profile with default values, type in a non-existent profile name in the Profile Name field, then click OK to return to the Ramp Soak Assignment screen.

If a valid profile is Assigned, clicking the Profile Name button displays the Special Ramp-Soak Functions screen, shown in Figure 5-13.

Refer to “Using Special Ramp/Soak Functions,” below for details about the menu options and screens you can access from the Special Ramp-Soak Functions screen.

Using Special Ramp-Soak Functions

To display the Special Ramp-Soak Functions window, shown in Figure 5-13, click the Profile Name column on the Ramp Soak Assignment screen for a channel to which a profile has been assigned.
The menus on the Special Ramp-Soak Functions window allow you to synchronize loops, modify segment times, and jump to other segments. When you are done using these menus, click *Done* from the Special Ramp-Soak Functions window to return.

**Synchronize**

Select *Loops* from the *Synchronize* menu to display the Channel Synchronization Setup window, shown in Figure 5-14, which allows you to synchronize loops.

To synchronize loops, follow these steps:

1. Click *Select Channels* to display a pull-down list box from which you can select the channels you want to synchronize.
2. From the list box, select the desired channels, then click *OK* to return to the Channel Synchronization Setup window.
3. Use the *Ramp-Soak mode to be downloaded* pull-down list box to select the mode you want to download for the selected channels.
4. Click *Download* to download the selected mode for the selected channels and return to the Special Ramp-Soak Functions window.
Jump

Select Jump from the menu bar to display the Jump to Ramp-Soak Functions window, shown in Figure 5-15. From this screen, you can jump to a different segment or modify the time remaining in the current segment.

To jump to a different segment, follow these steps:
1. Click Select Channels to display a pull-down list box from which you can select the channels you want to jump to a different segment.
2. From the list box, select the desired channels, then click OK to return to the Jump to Ramp-Soak Segment window.
3. Enter the segment number for the segment to which you want to jump in the Advance to segment field.
4. Click Download to jump to the specified segment and return to the Special Ramp-Soak Functions window.

To modify the time remaining for the segment that is currently running on the selected loop, follow these steps:
1. Use the Time remaining in segment fields to modify the time remaining.
2. Enter current segment number in the Advance to segment field.
3. Click Download to download your modification and return to the Special Ramp-Soak Functions window.

Status

Use the Status column to specify whether a profile is Assigned or Not Assigned to the loop. An Assigned loop operates as a ramp/soak loop. A Not Assigned loop operates as a standard control loop. Refer to "Profile Name," earlier in this section, for details about how to associate a profile with a loop.
Setting Channel Parameters

Edit/View Profile

The Edit/View Profile button allows you to access the Ramp Soak Edit screen, on which you can view and modify a selected profile.

To display the Ramp Soak Edit screen, follow these steps:

1. Click Edit/View Profile to display the Select File window, shown earlier in Figure 5-12, from which you can select a profile to edit or view.
2. Select the file name for the profile you want to edit or view, or type in a non-existent file name to create a new profile with default values.
3. Click OK to display the Ramp Soak Edit screen for that profile.

The following section tells you how to use the Ramp Soak Edit screen to edit profiles.

Editing Profiles

Figure 5-16 shows the Ramp Soak Edit screen. Using this screen—and other screens and windows that you access from it, you can modify the profile view displayed on the screen; define segment information—including triggers and events—for the segments in a profile; and define a profile’s ready state. When you are done using the Ramp Soak Edit screen, click Save to save your changes and return to the Ramp Soak Assignment screen.

FIGURE 5-16 Ramp Soak Edit Screen

The top portion of the Ramp Soak Edit screen displays the profile view—a graphical view of the selected profile, showing time on the horizontal axis and process setpoint on the vertical axis. Use the following controls to modify the profile view:

Spin: Use the buttons in the Spin panel to rotate the profile group Left or Right. These buttons do not work if Show Segs is selected.
Setting Channel Parameters

Show Segs: Select Show Segs to display the segment boundaries of the profile. You can display up to 20 segments.

Segs Displayed: Use the First and Last fields in the Segs Displayed panel to specify which segments you want to view.

The bottom portion of the Ramp Soak Edit screen displays a table of information and editable parameters for the running segments in the profile. Use the scroll bar at the bottom of the screen to scroll through the segments. Refer to “Defining Segment Information,” below, for details about using the segment table.

Defining Segment Information

Each column in the table at the bottom of the Ramp Soak Edit screen represents a segment. The rows display the following:

Segment #: The Segment # row displays the segment number. This is a read-only field.

Name: Use the Name row to enter a name for the segment.

Seg Time: Use the Seg Time row to enter a time (duration) for the segment. Segment time is unitless—it depends on how the ramp/soak time base field is set in the controller at the time the profile is run. The time base is either hours:minutes or minutes:seconds.

Total Time: The Total Time row displays the cumulative time for all the segments up to the edited segment. This is a read-only field.

Setpoint: Use the Setpoint row to enter the setpoint you want at the end of the segment.

Tolerance: Use the Tolerance row to enter the segment setpoint’s tolerance. If the difference between the PV and the setpoint is greater than the tolerance, the loop goes into tolerance wait state until the PV is back within setpoint tolerance. If you do not want to set a tolerance for the segment, enter 0 in this field.
Setting Channel Parameters

Trigger (#1 and #2): You can define up to two triggers per segment. Click Trigger #1 or Trigger #2 to display the Trigger window for that trigger. Figure 5-17 shows a sample Trigger window.

![FIGURE 5-17 Trigger Window](image)

To define a trigger, follow these steps:

1. Use the options in the State panel to specify whether the trigger is latched or unlatched and whether or not the trigger must be on.
   - Select Latched to define a latched trigger. Deselect Latched to define an unlatched trigger. A latched trigger, once it becomes active, is not checked again for the duration of the segment. An unlatched trigger is checked continuously during the segment.
   - Select Must be ON if you want to require a digital input to be on. Deselect Must be ON to require a digital input to be off.
2. Use the Input Number pull-down list box to select the input number for which you want to set the trigger. Select NONE for no trigger condition.
3. Click Save to save the trigger and return to the Ramp Soak Edit screen. A notation representing the trigger you defined now appears in the Trigger row. For example, the notation 1-ON-U indicates a trigger for input number 1 that is on and unlatched.

Event (#1, #2, #3, and #4): You can define up to four events per segment. An event is a digital output. Click Event #1, Event #2, Event #3 or Event #4 to display the Event window for that event. Figure 5-18 shows a sample Event window.

![FIGURE 5-18 Event Window](image)
To define an event, follow these steps:

1. Use the *Output ON* check box—in the State panel—to specify whether the digital output is on or off. Select *Output ON* to set the digital output to On. Deselect *Output ON* to set the digital output to Off.

2. Use the *Output Number* pull-down list box to select the output number you wish to toggle at the end of the segment you are editing.

3. Click *Save* to save the event and return to the Ramp Soak Edit screen. A notation representing the event you defined now appears in the Event row. For example, the notation *16-ON* indicates that an event will turn output 16 on.

**Defining Profile Ready States**

Click the *Ready* button in the upper left corner of the Ramp Soak Edit screen to display the Ramp Soak Ready State screen, shown in Figure 5-19. From this screen you can define the profile’s ready state—the setpoint and event outputs you want before the profile starts (i.e. before the timer starts ticking). When you are done defining the ready state, click the *Segment Editor* button to return to the Ramp Soak Edit screen.

![FIGURE 5-19 Ramp Soak Ready State Screen](image)

The Ramp Soak Ready State screen includes a three-dimensional profile view and the following controls that allow you to define the profile’s ready state:

**Ready Setpoint:** Use the *Ready Setpoint* field to enter the setpoint you want before the profile starts.

**Number of repeat cycles:** Use the *Number of Repeat Cycles* field to enter the number of cycles (1 to 99) that you want the profile to repeat automatically. For continuous cycling, enter 0.
Displayed Precision: Use the Displayed Precision field to set the number of decimal places for setpoints in a profile that will be run on a channel with input type set to linear. Channels with TC inputs always use a precision of -1.

Last Segment: Use the Last Segment field to enter the number of the last segment that will be executed in the profile.

Tolerance Time-Out Period: Use the Tolerance Time-Out Period field to enter the length of the tolerance time-out. If the PV is out of tolerance for longer than the amount of time you specify, an alarm occurs.

Digital Output States: Use the Digital Output States pull-down list boxes to set the event output (ON or OFF) that you want for each digital output before the profile starts.
Managing Recipes

This chapter explains how to use the options on the Recipe menu to manage all recipes. A recipe is a set of operating conditions for a process that can be stored on the computer hard disk and transmitted to the controller.

Recipe management allows you to create and store complete sets of operating parameters appropriate for each of the processes you run or tasks you perform. Comments saved with each recipe help you ensure the correct recipe is used each time. You can also schedule recipes to download automatically according to a schedule to set up using the calendar download feature.

Using the options on the Recipe menu, you can create new recipes; save, rename and delete existing recipes; download a recipe to the controller; and set up the program to download recipes automatically on a daily or hourly basis.

The Recipe menu includes the following options:

- New
- Open
- Save
- Save As
- Remove
- Download
- Calendar
**NOTE**

If you have enabled channel grouping, you will choose a group to work with immediately after selecting New, Open, Remove, or Download from the Recipe menu. Separate sets of recipes are maintained for each group.

### New

Select New to display the Recipe Editor screen, shown in Figure 6-1. From this screen, you can create new recipes based on an existing recipe. When you select New, the grid on the Recipe Editor screen is filled with the current controller values.

![Recipe Editor Screen](image)

**FIGURE 6-1** Recipe Editor Screen

**Recipe Spread Sheet**

The Recipe Editor screen includes a spread sheet that allows you to create a recipe. The parameters in the spreadsheet vary, depending on the controller. Refer to your controller manual for information about the various parameters.

To create a recipe using the spreadsheet, enter the desired operating parameters by double-clicking a cell with a numeric value and typing a new value or by using the pull-down selection boxes. Use the scroll bars to access parameters (columns) and channels (rows) beyond the borders of the Recipe Editor screen. You can also use the normal Windows editing keys: cut (Ctrl-X), copy (Ctrl-C), and paste (Ctrl-V).

**NOTE**

Editing recipe parameters has no effect on the controller(s) until the recipe is downloaded.
Print

Click Print to print the Recipe Editor screen to the current printer or to a file.

Enable Floppy Backup

Select Enable Floppy Backup to save a copy of the recipe files to drive a: when the recipe is saved.

Open

When you select Open, the Select Recipe screen, shown in Figure 6-2 appears. The File Name field contains recipe names, and the Comment field displays the comment or note associated with the recipe you highlight by clicking the file name.

Save

Select Save to save changes to the open recipe. Note that saving a recipe does not download the parameters to the controller; rather, it saves the recipe to the hard drive. Select Download from the Recipe menu to download a recipe to the controller.

Save As

Select Save As to save the parameters of the open recipe under a different name.

Use this command to create new recipes based on existing ones.
Managing Recipes

When you select \textit{Save As}, the Save Recipe As screen, shown in Figure 6-3, appears. Enter the new recipe name in the \textit{File Name} field and your comments in the \textit{Comment} field.

\begin{figure}[h]
\centering
\includegraphics[width=0.5\textwidth]{figure6_3}
\caption{Save Recipe As Screen}
\end{figure}

\textbf{Remove}

Select \textit{Remove} to display the Select Recipe screen, shown earlier in Figure 6-2.

Click on the file name of the recipe you want to remove, then click \textit{OK} to delete the recipe from your computer’s hard disk.

\textbf{Download}

Select \textit{Download} to send a recipe to the controller(s).

When you select \textit{Download}, the Select Recipe screen, shown earlier in Figure 6-2, appears.

Select the file name of the recipe you wish to download, then click \textit{OK} to download the recipe to the controller.

\textbf{Calendar}

Select \textit{Calendar} to set up a calendar start. When you select \textit{Calendar}, the Calendar Events screen, shown in Figure 6-4, appears.
Managing Recipes

FIGURE 6-4 Calendar Events Screen

The Calendar Events screen allows you to schedule the computer to download recipes to the controller(s) automatically. Use this feature to download different recipes for different shifts or products. The following subsections describe the major features of this screen.

Recipe Start

The Recipe start section is the heart of the Calendar Events screen. It is here that you will set up the calendar start.

Recipe Start Time

Use the Recipe Start Time panel to define the start time, either by entering a certain time in the field or by clicking the Now button. Set the recipe start time to be the time you want the computer to automatically download a recipe to the controller(s). You should schedule the download enough in advance to ensure that your processes can stabilize at the new setpoints.

Recipe Start Date

Use the Recipe Start Date panel to select the date(s) on which you want the recipe to be downloaded. You can set the recipe to load once, or every day, every weekend day, every weekday, or on specific days of the month.

Recipe Name

Select a recipe in the Recipe Name field, then use the Add, Delete, and Modify buttons to add/delete download events to/from the schedule and to change the time, date, or recipe to be downloaded for a scheduled event.
Managing Recipes

**Add.** Click *Add* to add the selected event to the schedule.

**Delete.** Click *Delete* to remove the selected event from the schedule.

**Modify.** Click *Modify* to change or edit the selected event.

### Monthly Calendar

Use the Monthly Calendar together with the Scheduled Recipes panel to show what recipes are scheduled to download for the selected calendar day.

### Scheduled Recipes

The Scheduled Recipes panel displays a list of all the scheduled recipe downloads for the day selected on the Monthly Calendar.

For each event, you see the time it is scheduled to download, the group, the recipe name, and the date of the last attempt to download it.

Select a day on the Monthly Calendar to display the scheduled downloads for that date.

The following symbols apply to scheduled recipes.

*:* Indicates that the recipe in the row is scheduled to download next.

*S:* Indicates that a recipe downloaded successfully.

*U:* Indicates that a recipe was not downloaded successfully. An unsuccessful download can be caused by a number of reasons; see the event log to find the specific cause.

### Suspend Calendar Events

If you need to suspend all calendar events—to perform maintenance, for example—select the *Suspend Calendar Events* check box. AnaWin will not perform any scheduled downloads if this option is selected.

Downloads scheduled for a time during which calendar events are suspended are skipped. AnaWin does not make any attempt to download, and the *Last Attempt* field remains blank. When you clear the *Suspend Calendar Events* check box, skipped downloads are not performed, but future downloading resumes.
Using the Trend Plot Screen

This chapter explains how to use the options on the Trend Plot menu to display and customize the Trend Plot screen—a graphical representation of process data. You can view both historical and real-time data on the Trend Plot screen.

The Trend Plot menu includes the following options:

- Trend Plot
- Trend Plot Settings
- Trend Plot Storage

Trend Plot

Select Trend Plot from the Trend Plot menu to display the Trend Plot screen. Figure 7-1 shows a sample Trend Plot screen.
Using the Trend Plot Screen

Trend Plot Screen Features

The following subsections describe the major features of the Trend Plot screen.

Plot Legend

The plot legend provides a key relating the colors and symbols used on the trend plots to the data sets they represent. AnaWin allows you to plot—and display legends for—up to nine data sets on the Trend Plot screen. You set up the data sets on the Plot Setup screen. Refer to “Trend Plot Settings,” later in this chapter, for details.

Trend Plot

The trend plot consists of a curve depicting each data set. Each curve represents the process variable, setpoint, or output variable for a channel. You select the data to be graphed on the Plot Setup screen. You can display up to nine data sets. Refer to “Trend Plot Settings,” later in this chapter, for details.

Trend Plot Adjust Buttons

The buttons in the upper right corner of the Trend Plot screen allow you to adjust the vertical axis of the trend plot. Controls along the bottom of the screen allow you to adjust the horizontal axis of the trend plot.
Using the Trend Plot Screen

**Last**

Click *Last* to return to the last scaling values for either the vertical or horizontal axis.

**Scale**

Click *Scale* to automatically scale the vertical axis of the plot so it displays the full range of data on the screen. Set the maximum attainable resolution that enables all data to appear on the graph.

**Now**

Click *Now* to display current data on the trend plot.

**Trend Plot Adjust Scroll Bars**

Use the scroll bars on the horizontal and vertical axes to move the trend plot and adjust its resolution.

**Move**

The Trend Plot screen includes two *Move* scroll bars: one on the horizontal axis and one on the vertical axis.

- Use the *Move* scroll bar on the horizontal axis to move the trend plot window. The Left arrow moves the window backward in time. The Right arrow moves the window forward in time.
- Use the *Move* scroll bar on the vertical axis to move the trend plot through the range of input, in engineering units. The Up arrow shifts the data up. The Down arrow shifts the data down.

**Res (resolution)**

The Trend Plot screen includes two *Res* (resolution) scroll bars: one on the horizontal axis and one on the vertical axis.

- Use the *Res* scroll bar on the horizontal axis to adjust the time frame displayed in the trend plot. The Left (-) arrow zooms out to show a longer length of time on the trend plot. The Right (+) arrow zooms in to show a shorter amount of time on the plot, thereby providing greater detail.
- Use the *Res* scroll bar on the vertical axis to increase or decrease the resolution of the trend plot. The Up (+) arrow increases the resolution of the plot and decreases the width of the plot’s scale. The Down (-) arrow decreases the resolution of the plot and increases the width of the plot’s scale.
**Extra Button**

Click Extra to display the Trend Extras window, shown in Figure 7-2.

![Trend Extras Window](image)

**FIGURE 7-2 Trend Extras Window**

Use the fields and buttons in the Trend Extras window to set slope, threshold, profile recording, and profile recall controls. When you are done, click OK to save your changes and return to the Trend Plot screen.

**Slope Controls**

The following slope controls allow you to set a time window for determining the slope and specify whether or not you want to display the boundaries used for the slope calculation on the graph. You define the slope boundaries in one of two ways:

- Define the centerpoint of the slope boundaries by clicking a point on the trend plot with the left mouse button.
- Define the actual left and right boundaries by holding down the Shift key and clicking the left mouse button and then the right mouse button.

**Slope time window:** Use the Slope time window field to set a time window (in seconds) for determining the slope. This option applies only if you define the centerpoint of the slope boundaries by left-clicking on the trend plot.

**Units list box:** Use the Units pull-down list box to select the time units for the slope calculation: engineering units/second or engineering units/minute.

**Bars:** Select Bars to display the slope boundaries on the graph. Deselect Bars to not display the slope boundaries on the graph.
Threshold Controls

Use the following threshold controls to set up to three threshold levels.

**Compute Now:** Click *Compute Now* to compute the duration (in seconds) above the threshold values and the peak temperature. Both calculations apply only to data displayed on the graph.

**Display on Graph:** Select *Display on Graph* to display the threshold levels on the trend plot. Deselect *Display on Graph* for no display of threshold levels.

**Threshold (#1, #2, #3):** Use the *Threshold* fields to enter up to three threshold values.

Profile Recording Controls

Use the following profile recording controls to define a profile—a subset of plot data defined by when you start and stop recording. Profiles are useful for oven performance comparisons.

**Start:** Click *Start* to start the profile recording.

**Stop:** Click *Stop* to stop the profile recording.

**Offsets:** Click *Offsets* to display the Reference Loop Setup window, shown in Figure 7-3. Use this window to set up the offsets of reference loops to be used for profile recording.

For example, consider a case in which T/C sensors are attached to a board moving through a reflow oven. Offsets refer to the sensor locations on a PCB relative to an arbitrary zero position.

When you are done setting reference loops, click *OK* to save your settings and return to the Trend Extras window.

![Reference Loop Setup Window](image_url)
The top portion of the Reference Loop Setup screen displays a table of sensor location offsets for each of the channels. Use the scroll bars to scroll through the table. To change an offset value, type over the value listed and press Enter. To select a channel, click on its name in the left column of the table. You can then use the Special Loop and Velocity Units pull-down list boxes, as described below, to set up a reference loop for that channel.

**Special Loop:** Use the Special Loop pull-down list box to select the reference loop. In the example earlier in this section, the Special Loop would be the loop controlling the belt speed.

**Velocity Units:** Use the Velocity Units pull-down list box to select the velocity units for the reference loop. In the example earlier in this section, the Velocity Units would refer to the velocity of the belt.

**Profile Recall Controls**

Use the following profile recall controls to recall selected channels for up to two profiles.

**Start:** Click Start to display recorded profiles on the graph.

**Stop:** Click Stop to remove profiles from the graph.

**Use distance for horizontal axis:** Select Use distance for horizontal axis to convert the time scaling of the horizontal axis.

**Display Real Time Data:** Select Display Real Time Data to display current data along with reference profile data.

**Chans:** Click Chans to display the Select Profile Channels to View window, shown in Figure 7-4.

![FIGURE 7-4 Profile Channels to View Window](image)

Use the Profile Channels to View window to select the profile channels to be displayed. When you are done selecting channels, click OK to return to the Trend Extras window.

**Number of channels:** Use the Number of channels field to enter to number of profile channels you want to be displayed.
Profile data sets: Use the Profile data sets field to set the channel name for each data set.

Channel selection: Use the Channel selection pull-down list box to select the profile channels you want to be displayed. The channels you select are listed in the Profile Channels to be displayed list.

Profile Channels to be displayed: The Profile Channels to be displayed field lists the profile channels that have been selected for display.

Select Prof 1: Click Select Prof 1 to display the Select File screen, from which you can select the first profile file you want to recall.

Select Prof 2: Click Select Prof 2 to display the Select File screen, from which you can select the second profile file you want to recall.

Slope Spreadsheet

To display the slope spreadsheet, click with the right mouse button anywhere on the trend plot (graph). Figure 7-5 shows a representative Trend Plot screen displaying the slope spreadsheet.

FIGURE 7-5 Trend Plot Screen with Slope Spreadsheet Displayed

The slope spreadsheet provides a table of slope information for each channel. Slopes are computed and displayed only for data sets depicting process variables (not setpoints or output variables). Each column in the table corresponds to a channel. Use the scroll bar to scroll through the following rows of data.
Slope: The Slope row lists the slope at the point where you clicked on the trend plot on the Trend Plot screen.

Left Value: The Left Value row lists the time and process variable value of the left hand point used for the slope calculation.

Right Value: The Right Value row lists the time and process variable value of the right hand point used for the slope calculation.

Keep slopes displayed: Click Keep slopes displayed to keep the slope spreadsheet displayed on the Trend Plot screen when you use the scroll bars.

Toolbar

The Trend Plot screen toolbar, shown in Figure 7-6, allows you to access property pages from which you can specify setup parameters for trend plots. The toolbar appears above the trend plot graph when the Display Tool Bar option is selected on the Trend Plot Settings screen.

Some icons in the toolbar are not used by AnaWin and are grayed-out. The following subsections describe the available icons. To return to the Trend Plot screen from a property page, click OK.

Titles

Click the Titles icon to display the Titles property page, shown in Figure 7-7, on this page you can enter text titles for your graph. You can place titles at the top, bottom, left or right of the graph.
Titles can be up to 80 characters long. When you enter text for a title, the Graph Control adjusts the rest of the trend plot to provide space—either by redrawing the graph and its associated objects at a smaller size or by decreasing the space between objects. When you delete the text from a title field, you disable the title and provide more space for the rest of the graph. If you enter a title that is too long to appear in a single line, the Graph Control automatically wraps it to appear on two lines.

**NOTE**

In some cases, a title may not display at all—even though it does not exceed the 80 character limit. This is because the Graph Control cannot make the font small enough to fit all the text in the space provided. In these cases, simply enter a shorter title.

**Graph Title:** Use the *Graph Title* field to enter text for the top title. This title appears centered at the top of the trend plot.

**Bottom Title:** Use the *Bottom Title* field to enter text for the bottom title. This title appears centered at the bottom of the graphing window. A bottom title frequently explains the X-axis.

**Left Title:** Use the *Left Title* field to enter text for the left title. The left title frequently explains the Y-axis.

**Right Title:** Use the *Right Title* field to enter text for the right title. The right title frequently explains the right-hand Y-axis when you have an overlay graph.

**Axis**

Click the *Axis* icon to display the Axis property page, shown in Figure 7-8. This page allows you to customize the X and Y-axes of a graph. You can also enable grid lines for the graph.
Using the Trend Plot Screen

**Apply to Axis:** Select an option from the Apply to Axis panel to specify the axis to which you want your settings to apply: X, Y Primary, or Y Overlay. The Y Overlay axis is used for the output variables, which are read on the right-hand vertical axis.

**Position:** The options in the position panel vary according to the axis selected in the Apply to Axis panel. You cannot set the position options for the Y Overlay axis because that axis is always drawn at the right and bottom right respectively.

- **Variable (default):** When X is selected in the Apply to Axis panel, select Variable to draw the X-axis intersecting the Y origin, either at the top, bottom, or middle of the graph. When Y Primary is selected in the Apply to Axis panel, select Variable to draw the primary Y axis intersecting the X origin, either at the left, right, or middle of the graph.

- **Top or Left:** When X is selected in the Apply to Axis panel, select Top to draw the X-axis at the top of the graph, regardless of the location of the Y origin. When Y Primary is selected in the Apply to Axis panel, select Left to draw the primary Y axis at the left edge of the graph, regardless of the location of the X origin.

- **Bottom or Right:** When X is selected in the Apply to Axis panel, select Bottom to draw the X-axis at the bottom of the graph, regardless of the location of the Y origin. When Y Primary is selected in the Apply to Axis panel, select Right to draw the primary Y axis at the right edge of the graph, regardless of the location of the X origin.

**Color of Axes (default is automatic black or white):** Use the Color of Axes pull-down list box, to choose a color for axes from the current color palette. The same color is applied to all axes. The default color is automatically black or white, whichever provides more contrast. Use the System property page, as described under “System” later in this chapter, to choose a new color palette.
Scale: The options in the Scale panel are always the same for X and Y graphs, though the default setting and the effects of each option vary.

- **Zero Origin (default for all X and Y graphs except time series):** Select *Zero Origin* to draw the axis including the origin (zero) and extending far enough in the positive and negative directions to include all of the graph's values.

- **Variable Origin:** Select *Variable Origin* to have the axis “zoom in” on the range of the graph's actual values, whether or not that range includes zero. For the X axis, this option differs from Auto only if you specify X values for data points.

- **User-Defined (default for time series graphs):** Select *User-Defined* to set your own values for the minimum, maximum, and number of ticks for the axis. When you select *User-Defined*, the settings in the Range panel are enabled.

Range: The options in the Range panel are enabled only if you select *User-Defined* in the Scale panel. The effect of each setting depends on the nature of the data.

- **Max:** The *Max* setting is generally the maximum point of the axis, with the following exceptions:
  - If you have a positive *Max* with a negative *Min*, the Graph Control may adjust the maximum or minimum point so that it lies on a tick.
  - For X axes without specific X values, the *Max* setting is ignored. The maximum point of the axis is equal to the number of points or sets you are graphing.

- **Min:** The *Min* setting is generally the minimum point of the axis, with the following exceptions:
  - If you have a positive *Max* with a negative *Min*, the Graph Control may adjust the maximum or minimum point so that it lies on a tick.
  - For X axes without specific X values, the *Min* setting is ignored. The minimum point of the axis is always 0.

- **Ticks:** The *Ticks* setting determines the number of ticks along the selected axis. (Note that ticks are distinct from tick marks, see “Tick Marks,” later in this section for details about tick marks.) The effect depends on the axis and the nature of your data.
  - For Y axes and X axes with specific X values the *Ticks* setting specifies the number of ticks from the origin to the setting of either *Max* or *Min*, whichever has the higher magnitude (distance from 0). For example, if you set *Min* to -50 and *Max* to 20, Ticks applies to the axis segment between 0 and -50.
  - To determine the *Ticks* value you want to set, divide the length of the axis (or axis segment) by the desired interval.
between ticks. For the axis segment 0 to -50 we've just described (whose length is 50 units), if you want to place ticks 25 units apart, set \textit{Ticks} to 2. Both the maximum and minimum points of an axis must fall on a tick. If you have a negative \textit{Min} with a positive \textit{Max}, the Graph Control may have to move the minimum or maximum point to make this happen. In our example axis, ticks would be placed at -50, -25, 0, and 25, overriding the \textit{Max} setting of 20.

\textbf{Labels:} The options in the \textit{Labels} panel allow you to enable labels for axes, choose the orientation (horizontal or vertical) for labels, and set the interval at which labels appear.

- \textbf{Show (default is on):} Select \textit{Show} to show labels along the axis. Deselect \textit{Show} for no labels. The Graph Control allows both text labels and numeric labels. If you do not use text labels, the Graph Control automatically generates numeric labels.

- \textbf{Vertical (available for X axis only; default is off):} Select \textit{Vertical} to display X labels vertically (rotated 90 degrees counterclockwise). Deselect \textit{Vertical} for horizontal labels. The \textit{Vertical} option is normally used with text labels. It lets you use a larger font for labels because you do not need as much space horizontally.

- \textbf{Every (available for X axis only; default is 1):} Use the \textit{Every} field to determine the frequency with which labels are displayed. A setting of 1 places a label at every tick along the X axis, a setting of 2 places a label at every other tick (beginning with the origin), and so on. If you have defined text labels for the X axis, these labels are displayed in the order of the X Labels. The Graph Control doesn't “skip” any of the label strings.

\textbf{Tick Marks:} The options in the Tick Marks panel allow you to enable or disable tick marks, set the frequency with which those marks are displayed, and enable or disable minor tick marks.

- \textbf{Show (available for X and Y Primary axes only; default is on):} Select \textit{Show} to draw tick marks along the axis. Deselect \textit{Show} for no tick marks. If you have a Y Overlay axis, your \textit{Show} setting for Y Primary also applies to Y Overlay. Either both axes have tick marks or both do not.

- \textbf{Minor (available for X, Y Primary, and Y Overlay axes; default is off):} Select \textit{Minor} to draw five “minor” tick marks between standard tick marks.

- \textbf{Every (available for X axis with zero or variable origin only; default is 1):} If you select \textit{Zero Origin} or \textit{Variable Origin} in the Scale group, you can use the \textit{Every} setting to specify the frequency with which tick marks are displayed along the X axis. An \textit{Every} setting of 1 places a mark at each tick, a setting of 2 places a mark at every other tick, and so on. The X axis must end with a tick mark. If you set an \textit{Every} value that does not include the last value on the axis, the Graph Control will
extend the axis so that it ends on a tick mark. This setting does not apply when you have set independent positional values.

**Grids:** The options in the grids panel allow you to enable grid lines for the X or Y axis and set their style and color.

- **Show (available for X and Y Primary axes only; default is off):** Select Show to draw grid lines perpendicular to the axis, intersecting each tick mark. Deselect Show for no grid lines.
- **Line Style (default is solid):** Use the Line Style pull-down list box to choose a style for grid lines. The same style is applied to both X and Y grids.
- **Color (default is automatic black or white):** Use the Color pull-down list box to choose a color for grids from the current palette. The same color is applied to both X and Y grids. The default color is automatically black or white, whichever provides more contrast. Use the System property page, as described under “System,” later in this chapter, to choose a different color palette.

**Fonts**

Click the Fonts icon to display the Fonts property page shown in Figure 7-9. This page lets you set the typeface and its style and size for your graphs titles, labels, and legend.

**Figure 7-9 Fonts Property Page**

- **Apply To (Fonts):** Select an option in the Apply To panel to specify the text to which you want to apply a font, style, and size.

- **Typeface:** Use the Options in the Typeface panel to select a typeface and the style in which to display it.

- **Size:** Use the options in the Size panel to select a size for the text.
Markers

Click the Markers icon to display the Markers property page, shown in Figure 7-10. From this page, you can customize the markers bars, and high-low-close symbols, on your graph. The various options let you set the color of markers, choose patterns for fills and lines, and select symbols and their size. Some options are only available for certain graph types.

FIGURE 7-10 Markers Property Page

Click to Select a Point or Set: When you move the mouse pointer over the graph drawing at the upper left of the Markers page, the pointer becomes a large arrow. Point and click on the graph marker to which you want to apply settings.

Apply to: The Apply to panel lists the set or point number of the graph object you have selected in the graph drawing, as described above.

- **Set**: For all graph types except pie, bubble, and bar graphs having one data set, a Set number is shown. Your settings apply to a particular data set.
- **Point**: For pie charts, bubble graphs, and bar graphs having one data set, a Point number is shown. Your settings apply to a particular data point.

Reset All: Click Reset All to return all settings in the Markers property page to their default values.

Color (default is automatic color selection): Use the Color pull-down list box to choose a color for the selected marker from the current palette. Use the System property page to choose a palette, as described under “System,” later in this chapter.

By default, the Graph Control assigns an automatic series of colors to markers, chosen for variety. If you override this default by setting your own color for one marker, you have to set colors for the remaining markers as well; otherwise, they will be shown in black.
Pattern (default is solid): Use the Pattern pull-down list box to choose a pattern for the selected marker. If you do not choose one, the marker appears in a solid color.

Symbol (default is automatic symbol): Use the Symbol pull-down list box to choose one of 14 symbol options.

By default, the Graph Control assigns an automatic series of symbols to data sets, chosen for variety. If you override this default by setting your own symbol for one set, you have to set symbols for any remaining sets as well; otherwise, they will all default to the first available symbol (+).

Size: Use the Size scroll bar to set the size for symbols, based on a default of 100 arbitrary units. Each click to the left decreases the symbol size by 5 units (to a minimum of 10), and each click to the right increases it by 5 units (to a maximum of 1000).

Lines: Use the options in the lines panel to specify the pattern and thickness for the lines on the trend plot.

- **Thick (default is on):** Select Thick to enable thick lines, which are three pixels thick by default. Deselect Thick for thin lines, which are one pixel thick.
  - You can use the pull-down list box to choose a line thickness of one to five pixels (overriding the default three pixels). This setting applies to all lines in the graph. You cannot set your own thickness for high-low-close or open-high-low-close markers, which are always three pixels thick when Thick is on.

- Patterned (default is off): Select Patterned to enable patterned lines, then, use the pull-down list box to choose a pattern for each line.

Trends

Click the Trends icon to display the Trends property page, shown in Figure 7-11. This page allows you to enable statistical lines and curve fitting for the graph types that support these options.
Using the Trend Plot Screen

Statistical Lines: Use the options in the Statistical Lines panel to enable one or more types of statistical lines. You can also set the color of statistical lines.

If you have enabled an overlay graph, your settings for statistical lines are applied to it. This may produce two sets of statistical lines on the same axis, depending on your primary graph type.

- **Mean (default is off)**: Select Mean to enable a mean line, which is drawn horizontally through the average value of all data points. Deselect Mean for no mean line. The Mean option applies to scatter, line, high-low-close and open-high-low-close, candlestick, and box-whisker (parametric data only) graphs. If you have enabled an overlay graph, your settings for statistical lines are applied to it.

- **Min/Max (default is off)**: Select Min/Max to enable min and max lines, which are drawn horizontally through the lowest and highest data points in a set. Deselect Min/Max for no min and max lines. The Min/Max option applies to scatter, line, high-low-close and open-high-low-close, candlestick, and box-whisker (parametric data only) graphs. If you have enabled an overlay graph, your settings for statistical lines are applied to it.

- **Std Deviation (default is off)**: Select Std Deviation to enable a pair of standard deviation lines, which are drawn horizontally through the standard deviation from the mean (in both the positive and negative directions). Deselect Std Deviation for no standard deviation lines. If you have enabled an overlay graph, your settings for statistical lines are applied to it.

- **Best Fit (default is off)**: Select Best Fit to enable a best fit line, which is a straight line indicating the trend of data points (a first-order polynomial curve). Deselect Best Fit for no best fit line.

- **Color (default)**: Use the Color pull-down list boxes to choose colors for statistical lines from the selected color palette. By default, statistical lines are drawn in the same color as the data sets they apply to. If you choose a color, it is applied to that type of line (mean, min/max, standard deviation, or best fit) for all data sets. Use the System property page to choose a color palette, as described under “System,” later in this chapter.
Curve Fit: Use the options in the Curve Fit panel to enable curve fitting. You can also set color, type, order, and granularity of curves.

If you have enabled an overlay graph, your curve settings are applied to it.

- **On (default is off):** Select On if you want to fit a curve through your data points. Deselect On for no curve. If you have enabled an overlay graph, your curve settings are applied to it.

- **Color (default is same color as data set):** Use the Color pull-down list box, to choose a color for the curve from the selected color palette. By default, curves are drawn in the same color as the data sets they apply to. If you choose a color, it is applied to the curves for all data sets. Use the System property page to choose a color palette, as described under “System,” later in this chapter.

- **Curve Type (default is Variable-Order Polynomial):** Use the Curve Type pull-down list box to choose a curve type from the Graph Control’s 13 available options:
  
  - Variable-Order Polynomial: Polynomial curve of variable order
  - Logarithmic: \( y = a + b \times \log(x) \)
  - Exponential 1: \( y = a \times \exp(b \times x) \)
  - Exponential 2: \( y = a \times x \times \exp(b \times x) \)
  - Power: \( y = a \times (x^b) \)
  - Inverse 1: \( y = a + b / x \)
  - Inverse 2: \( y = a / (b + x) \)
  - Inverse 3: \( y = 1 / (a + b \times x) \)
  - Inverse 4: \( y = x / (a \times x + b) \)
  - Inverse 5: \( y = 1 / (a + b \times x)^2 \)
  - Spline fit through all points
  - Moving Average Mid: moving average plotted at midpoint of averaged group
  - Moving Average End: moving average plotted at end point of averaged group

- **Order (default is 2):** The Order field applies only to three curve types: For variable-order polynomial curves, Order is the order of the polynomial used in curve fitting. A setting of 1 produces a straight line (the same as a best-fit line); a setting one less than the number of points produces a curve that passes through every point.
For moving-average mid and moving-average end curves, Order is the range of data points over which moving averages are averaged, beginning with the first point.

- **Granularity:** Use the Granularity scroll bar to set the granularity of all curve types except moving-average. The granularity is the number of “steps,” or straight line segments, making up the curve. Higher values create smoother curves, but require more drawing time.

  - The default Granularity setting is 50 curve steps, which generally creates a smooth-looking curve at a high drawing speed. Each click to the left decreases the number of steps by 2 (to a minimum of 10), and each click to the right increases the number of steps by 2 (to a maximum of 1000). With spline curves, you generally need higher granularity than normal—up to 10 times the number of points in the graph.

**Background**

Click the Background icon to display the Background property page, shown in Figure 7-12. This page handles a variety of tasks. You can use it to set the background color of the graphing window, apply styles and colors to different graph objects, set the position of a graph's legend, and add a bitmap background to the graphing window.

**FIGURE 7-12 Background Property Page**

**Apply To:** Use the options in the Apply To panel to select the graph object to which you want to apply styles and colors: Graph Title (default), Bottom Title, Left Title, Right Title, Legend, or Graph (including the graph itself and its axes).

**Style:** Use the options in the panel to set the text color, background color, and styling options for the selected graph object.

**Legend:** Use the options in the Legend panel to set the parameters for the graph's legend.

**Graph Window:** Use the options in the Graph Window panel to assign a color or backdrop file to the graph window.
• **Background Color (default is light gray):** Use the *Background Color* pull-down list box to choose a background color for the graphing window from the current color palette. Use the System property page to choose a color palette, as described under “System,” later in this Chapter.

• **Backdrop (default is None):** Use the *Backdrop* pull-down list box to choose a type of graphic image (*bitmap*, *metafile* or *none*) to use for the backdrop of the graphing window. You can also choose how the image is displayed—centered, tiled, or stretched.

• **File:** Use the *File* field to enter the filename for the graph's backdrop image. If you do not include a path to the file as part of this string, the Graph Control searches the current directory. The appropriate file extension (.BMP or .WMF) is added automatically, according to your selection in the Backdrop list box.

• **Browse:** Click *Browse* if you want to call up a standard Windows Open dialog to locate a backdrop file.

**System**

Click the *System* icon to display the System property page, shown in Figure 7-13. This page allows you to set printing parameters, export a copy of the trend plot, and choose a color palette.

![System Property Page](image)

**FIGURE 7-13 System Property Page**

**Printing:** Use the options in the Printing panel to set print parameters and print a plot. To plot data other than the defaults, configure each data set individually, as described below.

• **Border (default is off):** Select *Border* to include a border around the graphing window when you print it. Deselect *Border* for no border.

• **Mono (default):** Select *Mono* to print in monochrome, with a white background and black objects. The Graph Control supplies varying patterns, symbols, and line thicknesses to differentiate data sets and points from each other.

• **Color:** Select *Color* to print in color or grayscale. The graphing window is printed as it appears on the screen.
Using the Trend Plot Screen

**Print Trend Plot:** Click *Print Trend Plot* to print the trend plot (graphing window) on the current printer.

**Color Palette:** Use the *Palette* pull-down list box in the Color Palette panel to choose a color palette.

**Export:** Use the options in the Export panel to copy an image of the trend plot to disk or the clipboard.

### Trend Plot Settings

Select Trend Plot Settings to display the Plot Setup screen, shown in Figure 7-14. This screen allows you to set up the parameters to be plotted. You can display up to nine trends or data sets.

**Data Sets**

The data sets parameters, shown in Figure 7-15, refer to a specific plot entry. For instance, a data set could be the Process Variable (PV) for Controller 1, Channel 3. Up to nine data sets can be displayed on the plot at one time. You must set up each data set individually.
Number of Data Sets Displayed

Use the Number of Data Sets Displayed field to define the number of data sets that appear on the plot. Once you enter a number in this field, the defaults for those data sets appear in the pull-down list boxes below the Data Set to View field. To plot data other than the defaults, configure each data set individually, as described below.

Data Set to View

Use the Data Set to View field and the associated list boxes to configure each of the data sets. For each data set specify a controller, a channel, and a variable to plot: Process Variable (PV), Setpoint (SP), Output 1 Percent (OV1), or Output 2 Percent (OV2).

Graphing Limits

Use the graphing limits parameters, shown in Figure 7-16, to set the high and low graph limits for the trend plot. These limits provide a window through which to view the plot. Set the limits with all the plot variables in mind. If data is outside the high or low graph limits, it will not be visible on the screen, although you can use the Scale button to automatically scale the vertical axis when viewing the plot.

<table>
<thead>
<tr>
<th>Graph Hi Limit</th>
<th>202.5</th>
</tr>
</thead>
<tbody>
<tr>
<td>Graph Lo Limit</td>
<td>141.75</td>
</tr>
</tbody>
</table>

FIGURE 7-16 Graphing Limits Parameters

Time Range

Use the time range parameters, shown in Figure 7-17, to set a beginning and end time frame for trend plotting. All references are in 24-hour time.

<table>
<thead>
<tr>
<th>Begin Time (Hrs:Mins)</th>
<th>15:20</th>
</tr>
</thead>
<tbody>
<tr>
<td>End Time (Hrs:Mins)</td>
<td>15:51</td>
</tr>
</tbody>
</table>

FIGURE 7-17 Time Range Parameters

Trend Plot Storage

Select Trend Plot Storage to display the Data Storage settings screen, shown in Figure 7-18. This screen provides information and parameters related to storing plot data files.
Using the Trend Plot Screen

Disk Space Analysis

AnaWin examines your hard drive and displays the amount of disk space available for data storage and how many days of data can be collected based on current hard disk space for current recording rate.

Recording Rate

Use the Recording Rate field to specify how frequently data is collected for defining data points on the plot screen. The number of seconds you enter here will directly affect how much disk space is required. For instance, one day of data saved at a recording rate of 5 seconds requires twice as much disk space as it would at a recording rate of 10 seconds.

Maximum Days Stored on Disk

Use the Maximum Days Stored on Disk field to set the number of days of historical data collected for plotting. AnaWin does not maintain trend plot data indefinitely, but you can save data for any number of days allowed (as determined by available disk space). The available disk space will also be impacted by the recording rate, as described above.

NOTE

If you wish to preserve data indefinitely, you can export the data using the Export Database option from the File menu. If you anticipate the need to store data for a long period of time, you can enable the Data Logging feature by selecting Data Log Setup from the File menu.
This chapter explains how to use the options on the View menu to select different ways to monitor system data. You can view data in spreadsheet format or as a bar graph and view the digital I/O in real time or on custom overview screens. The View menu includes the following options:

- Spreadsheet
- Bar Graph
- Digital I/O
- Custom Overview Screens
- Overview Thumbnails

**Spreadsheet**

Select Spreadsheet to view the Spreadsheet Overview screen, shown in Figure 8-1. This screen displays all channels in rows and columns. The spreadsheet format allows you to easily view all channels at the same time.

**NOTE**

If channel groups have been established, only the channels assigned to the selected group are displayed.
Viewing Channels

FIGURE 8-1 SpreadSheet Overview Screen

The Process Variable (PV) column displays system status, by color, for each channel. The color designators are as follows:

Red = The process variable is outside the high process or low process limits.

Yellow = The process variable is outside the high or low deviation.

Green = The process variable is within deviation band.

Bar Graph Display

Select Bar Graph Display to view channels as a series of small bar graphs, as shown in Figure 8-2. The bar graphs are updated in real time and indicate deviation from setpoint with color. If your system has more than 96 loops, press the Page-Up and Page-Down keys to scroll through all the loops.

To view the gauge display, double-click the six-channel group you wish to view or press the associated hotkey letter on your keyboard.

Gauge Display

The gauge display, shown in Figure 8-3, provides a more detailed view of the bar graph. Up to six channels are displayed at a time. Press the Page-Up and Page-Down keys to see other channels.
FIGURE 8-3 Gauge Display

Channel Setup Jump

Click the Channel Setup Jump button to jump to the channel parameters screen for the selected channel.

Bar Graph

Each gauge’s bar graph is centered on the setpoint of the corresponding loop. The setpoint is indicated by the triangular symbol and highlighted in blue. The level of the colored bar indicates the process variable value graphically. The color of the bar indicates the value of the process variable relative to the process alarm and deviation settings.

Control Mode

The Control Mode field displays the control mode for each loop: Auto, Manual, or Tune.

Percent of Full Scale

Use the Percent of Full Scale field to set the scale displayed on the gauges. Larger percentages produce gauges with less detail or resolution. Smaller percentages produce gauges with greater resolution.

Previous Screen

Click Previous Screen to return to the bar graph display.
**Editable Parameters**

If you have enabled the Gauge Display Editable Parameters on the Preferences screen, you can edit the following fields by double-clicking them, typing the change, and pressing the Enter key.

- Setpoint
- Control Mode
- Heat PID Output %
- Cool PID Output %

You can set the Heat PID Output % and Cool PID Output % only when the channel is in manual control mode.

**Digital I/O**

Select Digital I/O to display the Digital I/O screen, shown in Figure 8-4. This screen allows you to view the controller’s digital inputs and outputs.

*FIGURE 8-4 Digital I/O Screen*

**Inputs**

Simulated LEDs show the status of the inputs. If an input is High (green), it is at 5 volts. If the input is Low (red), it is at 0 Volts. Inputs are read-only. You can test an input by shorting it to controller common and watching the LED change on the screen. Inputs will read high when not connected to anything and low when grounded to the controller common.

**Outputs**

You can set outputs manually to high or low. Any output that has been previously assigned as a control output will not be selectable. For instance, in the example shown in Figure 8-4, outputs 1 through 9 are used as control outputs for the channels and cannot be toggled on the screen.
NOTE
To view output assignment, right-click on the output name on the Digital I/O screen. A popup displays the assignment for the selected output.

Overview Thumbnails

Select Overview Thumbnails to display the Overview Thumbnails screen shown in Figure 8-5.

![Overview Thumbnails Screen](image)

FIGURE 8-5 Overview Thumbnails Screen

The Overview Thumbnail screen displays small versions of saved custom overview screens. Up to eight Thumbnails appear on the screen at a time. Use the scroll bar to bring additional thumbnails into view.

To go to the associated custom overview screen from a thumbnail on the Overview Thumbnail screen, click the thumbnail for the custom overview you want to view, then click OK—or double-click the thumbnail. Refer to “Using the View Manager,” in Chapter 10, for details about assigning shortcuts to custom overview screens. A thumbnail is created for every custom overview when the custom overview is saved.
Custom Overview Screens

Custom overviews appear on the View menu only if they have a shortcut associated with them. Refer to the Chapter 10 for details about assigning shortcuts to custom overview screens and information on how to create custom overview screens. Figure 8-6 shows a sample custom overview screen.

**FIGURE 8-6** Sample Custom Overview Screen
Working with Log Files

This chapter explains how to use the options on the Logs menu to view, print, copy, and remove log files related to system events. You can view all events for a single day pertaining to User, Alarm, or System events.

Log files can be useful when you are troubleshooting a process or trying to determine what tasks have been accomplished after a shift change.

The Logs menu includes the following options:

- View
- Print
- Copy to A:
- Remove

View (Logs)

Files are listed sequentially by date. The log file name format is as follows:

```
LG052096.LOG
```

Month   Day   Year
Select View to display the Log File Selection screen, shown in Figure 9-1. From this screen, you select the log file you want to view. Click on the file you wish to view, then click OK to open the log file.

![Log File Selection Screen](image1)

FIGURE 9-1 Log File Selection Screen

AnaWin displays all events that occurred on the selected date, as shown in Figure 9-2.

![Open Log File](image2)

FIGURE 9-2 Open Log File

**Log File**

Displays the file name for the selected log file.

**Time of Event**

Displays the time each event occurred.

**Event Numbers**

Event numbers are used in the log file to designate the type of event that occurred. There are three event types: User Events, Alarm Events, and System Events. Table 9-1 shows the number sequences for these events.
Working with Log Files

TABLE 9-1  Event Number Sequences

<table>
<thead>
<tr>
<th>Event Type</th>
<th>Event Number Range</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Events</td>
<td>(1000 to 1999)</td>
<td>Events performed by the user.</td>
</tr>
<tr>
<td>Alarm Events</td>
<td>(2000 to 2999)</td>
<td>Events causing an alarm.</td>
</tr>
<tr>
<td>System Events</td>
<td>(0000 to 0999)</td>
<td>Events performed by system software.</td>
</tr>
</tbody>
</table>

Tables 9-2, 9-3, and 9-4 list the events that are currently logged by AnaWin:

TABLE 9-2  User Events

<table>
<thead>
<tr>
<th>Event Number</th>
<th>Event Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1000</td>
<td>Menu action</td>
</tr>
<tr>
<td>1001</td>
<td>Message box</td>
</tr>
</tbody>
</table>

TABLE 9-3  Alarm Events

<table>
<thead>
<tr>
<th>Event Number</th>
<th>Event Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2000</td>
<td>Channel alarm</td>
</tr>
<tr>
<td>2500</td>
<td>System alarm message box</td>
</tr>
</tbody>
</table>

TABLE 9-4  System Events

<table>
<thead>
<tr>
<th>Event Number</th>
<th>Event Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0002</td>
<td>Program startup</td>
</tr>
<tr>
<td>0003</td>
<td>Program exit</td>
</tr>
<tr>
<td>0004</td>
<td>Recipe download attempt disabled by I/O status</td>
</tr>
<tr>
<td>0005</td>
<td>Recipe download attempt has been disabled by digital I/O</td>
</tr>
<tr>
<td>0006</td>
<td>Communications retry</td>
</tr>
<tr>
<td>0007</td>
<td>Communication has failed with controller at address</td>
</tr>
<tr>
<td>0008</td>
<td>Calendar recipe download</td>
</tr>
<tr>
<td>0009</td>
<td>Error reading recipe: file</td>
</tr>
<tr>
<td>0010</td>
<td>Communications error—failure downloading</td>
</tr>
<tr>
<td>0011</td>
<td>Communication has been re-established with controller at address</td>
</tr>
<tr>
<td>0012</td>
<td>OLE recipe downloaded</td>
</tr>
</tbody>
</table>

Event Description

Gives a brief description of the event.
Search

Click Search to perform a search in the selected AnaWin log file. You can search for any key word or event number. Type in the word or number for which you want to search in the Find What? field, then click Find Next.

The search tool will immediately move to the first matching entry it finds and highlight it. Continue searching by pressing Find Next. If no entries are found, nothing is highlighted.

Print

Select Print to print an open log file. Before the print feature is available, you must first load a log file using the View option as described above. When you have opened a file Print becomes available on the Logs menu. When you select Print, a print screen appears, allowing you to send the print job to a designated printer.

Copy to A:

Select Copy to A: to display the Log File Selection screen shown earlier, in Figure 9-1. From this screen, you can select a log file, or several log files to copy to a floppy disk.

From the log file list, click on the file(s) you wish to copy, then click OK. AnaWin saves the selected log files to the floppy disk.

Remove (Logs)

Select Remove to display the Log File Selection screen shown earlier, in Figure 9-1. From this screen, you can select a log file, or several log files, to remove from your hard drive.

From the log file list, click on the file(s) you wish to remove, then click OK. AnaWin deletes the selected log files from the hard drive.

Closing a Log

To close a log file, simply select another screen to view. For example, if you select Spreadsheet from the View menu, the currently-displayed log file is closed.
Using the Developer

This chapter explains how to use the options on the Developer menu to create custom overview screens as a real-time interface to your system and how to define user variables for use with your custom overview screens.

Using the Developer Program

The Developer program allows you to tailor custom overview screens so data is laid out on the screen in a way that is most relevant for your product or application. You can also add bitmap images and backgrounds to make it clear to the operator how the displayed data relates to the physical process being controlled. Figure 10-1 shows a sample custom overview screen.
After you create a custom overview screen, you can select it from the View menu or designate it as the primary user interface (the first custom overview screen in the queue that loads when you start up AnaWin).

The Developer menu includes the following options:

- Design Custom Overview
- User Variables
Design Custom Overview

Select Design Custom Overview from the Developer menu to enter design mode. A dialog box appears, informing you that alarms will be received but not displayed in design mode. Click Yes to continue. A new Custom View screen appears, as shown in Figure 10-2.

![Custom View Screen](image)

**FIGURE 10-2** Custom View Screen

Use the New View or Open View option from the File menu to create a new custom overview screen or open an existing custom overview screen for modification.

- Select New View from the File menu to open a blank Custom View screen on which you can create a new custom overview screen.
- Select Open View from the File menu to display the Overview Thumbnails screen, shown in Figure 10-3, from which you can select an existing custom overview screen to modify. Select the desired custom overview screen by double-clicking its thumbnail or by clicking its thumbnail, then clicking OK to open the corresponding Custom View screen.

**NOTE**

You can save only up to 32 custom overviews. If you have 32 saved, you will need to delete one before you can save another custom overview.
When you are done creating your custom overview screen, as described in the following sections, select Save from the File menu to save the current file. AnaWin prompts you if you are overwriting another file of the same name.

Select Delete from the File menu to display the Overview Thumbnails screen, shown above in Figure 10-3, from which you can select a custom overview screen to delete. Select the custom overview you want to delete by double-clicking its thumbnail or by clicking its thumbnail, then clicking OK to delete that file.

To exit design mode and return to normal operation, select Exit to Normal Operation from the File menu.

**Working with Screen Objects**

Your custom overview screens can include any of the objects listed below, which appear in the layers indicated. Anything contained in a layer closer to the front covers anything in the layer(s) behind it. Animations do destructive writes to the screen, so they are always in front at runtime but not during design mode.

- Form (back)
- Label (front)
- Field (front)
- Digital I/O Text (front)
- Digital I/O Image (middle)
- Graphic (middle)
- User Variable (front)
- Animation (special)
- Zoom (middle)

For objects in the same layer, the stacking order is first added on bottom, last added on top.
Adding an Object

To add an object, click the corresponding add button at the top of the screen, shown below in Figure 10-4. Then set the properties for that object as described below under “Setting Object Properties.”

Deleting an Object

To delete an object, select the object by clicking on it, then press the backspace key.

Copying an Object

To copy an object, select the object by clicking on it, then click the corresponding add button. Note that some properties—such as position—do not copy.

NOTE

Whenever you select an object, its type is displayed in the message box at the bottom left of the screen.

Modifying an Object

To modify an object, select the object by clicking on it, then edit the parameters as described below under “Setting Object Properties.”

Moving an Object

To move an object, hold the Shift key while clicking and dragging the object.

- If you are moving a single object, release the mouse button first, then the Shift key when the object is in the desired position. This takes you out of move mode.
- If you are moving multiple objects, release the Shift key first, then the mouse button. This keeps you in move mode, and you can then click and drag additional objects. To get out of move mode, press and release the Shift key.
NOTE
Whenever you select an object, its position, in pixels, is indicated in
the message box at the bottom left of the screen. Left \([x]\) and top \([y]\)
indicate the position of the object’s top left corner relative to the top
left corner of the screen.

Sizing Objects

You can size all text objects (label, digital I/O text, field, and user
variable) directly by using the mouse and sizing handles which appear
on the selected object when it is in move mode. Click and drag the
handle corresponding to the dimension in which you want to increase or
decrease size.

NOTE
Whenever you select an object and keep the pointer (mouse) on it,
the object’s size is indicated in the message box at the bottom left
of the screen. Width \([x]\) and height \([y]\) are the object’s width and
height, in pixels.

Setting Object Properties

When you add or select an object on the Custom View screen, a
Properties table for that type of object appears. Modify the settings to
specify properties for the selected object. To refresh the Properties
tables, select Refresh Toolbars from the Tools menu. The following
subsections describe the Properties tables for each of the available
object types.

Form Properties

To display the Form Properties table, shown in Figure 10-5, click
anywhere on the workspace. Use the Form Properties table to set
properties that pertain to the custom overview screen as a whole.

![Figure 10-5 Form Properties Table](image-url)
You can set the following form properties:

**Caption:** Use the Caption field to enter a name for the custom overview screen, then press Enter. If you do not enter a name for the screen, AnaWin will assign it the default name *Custom View*. When you save the custom overview and return to AnaWin, the screen name you entered will appear under the Custom Overviews submenu on the View menu.

**Bkgrnd Color:** Click the Bkgrnd Color setting to display a color selection dialog box from which you can specify a color to be used as the background for the custom overview screen.

**Graphic Image:** Click the Graphic Image setting to display the Add Graphic screen, shown in Figure 10-6. From this screen, you can select a bitmap (BMP), windows metafile (WMF), or icon (ICO) file to add to your custom overview screen.

![Add Graphic Screen](image)

**FIGURE 10-6 Add Graphic Screen**

To add a graphic to a custom overview screen, follow these steps:
1. Select an option from the File Types panel to specify the type of file that you want to add.
2. Enter the file name in the File Name field or use the Directories and Drives scroll boxes to browse for the desired file.
3. Select the file by clicking on its name in the File Name field.
4. If desired, select Preview to display the graphic in the preview box. For larger graphics, you may need to select Shrink To Fit in order to fit the graphic into the preview window. The Shrink to Fit option affects the preview only.
5. Click OK to add the graphic to your custom overview screen.

**Label Properties**

Use the Label Properties table, shown in Figure 10-7, to format the labels you add to your custom overviews. Labels are text-only references.
You can set the following label properties:

**Caption:** Use the *Caption* field to enter the text for the label, then press Enter.

**Font Name:** Click the *Font Name* setting to display a dialog box from which you can select a font to be used for the label text.

**Font Size:** Click the *Font Size* setting to display the Font dialog box from which you can select a font size to be used for the label text.

**Font Bold:** Click the *Font Bold* setting to display the Font dialog box from which you can specify whether the label text will be bold (True) or not (False).

**Font Italic:** Click the *Font Italic* setting to display the Font dialog box from which you can specify whether the label text will be italic (True) or not (False).

**Text Color:** Click the *Text Color* setting to display a dialog box from which you can specify a color to be used for the label text.

**Bkgrnd Color:** Click the *Bkgrnd Color* setting to display a dialog box from which you can specify a background color to be used for the label text. To make the text box invisible, select the same background color that you did for the custom overview screen (in the Forms Property table).

**Alignment:** Use the *Alignment* pull-down list box to select an alignment for the label text: *Left*, *Right*, or *Center*.

**Font Rotate (deg):** Use the *Font Rotate (deg)* pull-down list box to select the number of degrees you want the label text to be rotated: 0 (horizontal), 90, 180, or 270. Note that only TrueType fonts will rotate.

**Bevel Size:** Use the *Bevel Size* field to enter the size of the bevel that surrounds the label, then press Enter. If you do not want a bevel, enter 0 in this field.
Bevel Style: Use the Bevel Style pull-down list box to select the style of the bevel that surrounds the label: Lowered or Raised.

Height (Pixels): Use the Height field to enter the height (in pixels) for the label, then press Enter.

Width (Pixels): Use the Width field to enter the width (in pixels) for the label, then press Enter.

Top Position: Use this field to enter the top position (the number of pixels from the top of the screen, under the toolbar) for the label on the custom overview screen.

Left Position: Use this field to enter the left position (the number of pixels from the left of the screen) for the label on the custom overview screen.

Field Properties

Use the Field Properties table, shown in Figure 10-8, to configure the fields you add to your custom overviews. A field displays real-time data that is read from a specified controller but does not update in design mode.

![Field Properties Table](image)

FIGURE 10-8 Field Properties Table

You can set the following field properties:

Controller Type: Use the Controller Type pull-down list box to select an available controller type.

Controller Name: Use the Controller Name pull-down list box to select an installed controller of the type selected in the Controller Type list box.

Channel Name: Use the Channel Name pull-down list box to select a channel.
Parameter Type: Use the Parameter Type pull-down list box to select a parameter type:

- **Channel**: Provides channel parameters from the selected controller. You must specify both the Channel Name and the Parameter Name.
- **Global**: Provides global parameters for controllers of the selected Controller Type.

Ramp/soak parameters are displayed if you select a Controller Type that is a ramp/soak controller.

Parameter Name: Use the Parameter Name pull-down list box to select a specific parameter of the type selected in the Parameter Type list box.

Editing Enabled: Use the Editing Enabled pull-down list box to specify whether the field is read-only (False) or user-editable (True). Only parameters that are in the recipe are editable.

Font Name: Click the Font Name setting to display the Font dialog box from which you can select a font to be used for the field text.

Font Size: Click the Font Size setting to display the Font dialog box from which you can select a font size to be used for the field text.

Font Bold: Click the Font Bold setting to display the Font dialog box from which you can specify whether the field text will be bold (True) or not (False).

Font Italic: Click the Font Italic setting to display the Font dialog box from which you can specify whether the field text will be italic (True) or not (False).

Text Color: Click the Text Color setting to display a dialog box from which you can specify a color to be used for the field text.

Bkgrnd Color: Click the Bkgrnd Color setting to display a dialog box from which you can specify a background color to be used for the field.

Alignment: Use the Alignment pull-down list box to select an alignment for the field text: Left, Right, or Center.

Font Rotate (deg): Use the Font Rotate (deg) pull-down list box to select the number of degrees you want the field text to be rotated: 0 (horizontal), 90, 180, or 270. Note that only TrueType fonts will rotate.

Bevel Size: Use the Bevel Size field to enter the size of the bevel that surrounds the field, then press Enter. If you do not want a bevel, enter 0 in this field.
Bevel Style: Use the Bevel Style pull-down list box to select the style of the bevel that surrounds the field: Lowered or Raised.

Height (Pixels): Use the Height field to enter the height (in pixels) for the field, then press Enter.

Width (Pixels): Use the Width field to enter the width (in pixels) for the field, then press Enter.

Top Position: Use this field to enter the top position (the number of pixels from the top of the screen, under the toolbar) for the field on the custom overview screen.

Left Position: Use this field to enter the left position (the number of pixels from the left of the screen) for the field on the custom overview screen.

Digital I/O Text Properties

Use the Digital I/O Text Properties table, shown in Figure 10-9, to format text displays of the state of digital input or output.

![Digital I/O Text Properties Table](image)

You can set the following digital I/O text properties:

Controller Type: Use the Controller Type pull-down list box to select an available controller type.

Controller Name: Use the Controller Name pull-down list box to select an installed controller of the type selected in the Controller Type list box.

Digital Type: Use the Digital Type pull-down list box to select whether the reference is an Input or an Output.

I/O Name: Use the I/O name pull-down list box to select an available I/O point of the selected Digital Type.

Editing Enabled: Use the Editing Enabled pull-down list box to specify whether the reference is read-only (False) or user-editable (True). Inputs and global outputs are not editable.
Font Name: Click the Font Name setting to display the Font dialog box from which you can select a font to be used for the digital I/O text reference.

Font Size: Click the Font Size setting to display the Font dialog box from which you can select a font size to be used for the digital I/O text reference.

Font Bold: Click the Font Bold setting to display the Font dialog box from which you can specify whether the digital I/O text reference will be bold (True) or not (False).

Font Italic: Click the Font Italic setting to display the Font dialog box from which you can specify whether the digital I/O text reference will be italic (True) or not (False).

Alignment: Use the Alignment pull-down list box to select an alignment for the digital I/O text reference: Left, Right, or Center.

Font Rotate (deg): Use the Font Rotate (deg) pull-down list box to select the number of degrees you want the digital I/O text reference to be rotated: 0 (horizontal), 90, 180, or 270. Note that only Truetype fonts will rotate.

Bevel Size: Use the Bevel Size field to enter the size of the bevel that surrounds the digital I/O text reference, then press Enter. If you do not want a bevel, enter 0 in this field.

Bevel Style: Use the Bevel Style pull-down list box to select the style of the bevel that surrounds the digital I/O text reference: Lowered or Raised.

Text When High: Use the Text When High field to enter the text to be displayed when the I/O point is high, then press Enter.

Text Color-Hi: Click the Text Color-Hi setting to display a color selection dialog box from which you can select a text color to be used when the I/O point is high.

Bkgrnd Color-Hi: Click the Bkgrnd Color-Hi setting to display a color selection dialog box from which you can select a background color to be used when the I/O is high.

Text When Low: Use the Text When Low field to enter the text to be displayed when the I/O point is low, then press Enter.

Text Color-Lo: Click the Text Color-Lo setting to display a color selection dialog box from which you can select a text color to be used when the I/O point is low.

Bkgrnd Color-Lo: Click the Background Color-Lo setting to display a color selection dialog box from which you can select a background color to be used when the I/O point is low.
**Test Button:** Click the Test button to preview the settings you have made. Each time you click the Test button, the digital I/O test object changes display states.

**Height (Pixels):** Use the Height field to enter the height (in pixels) for the field, then press Enter.

**Width (Pixels):** Use the Width field to enter the width (in pixels) for the field, then press Enter.

**Top Position:** Use this field to enter the top position (the number of pixels from the top of the screen, under the toolbar) for the digital I/O text on the custom overview screen.

**Left Position:** Use this field to enter the left position (the number of pixels from the left of the screen) for the digital I/O text on the custom overview screen.

**Digital I/O Image Properties**

Use the Digital I/O Image Properties table, shown in Figure 10-10, to select graphics to indicate the state of a controller’s input or output.

![FIGURE 10-10 Digital I/O Image Properties Table](FIGURE 10-10 Digital I/O Image Properties Table)

You can set the following digital I/O image properties:

**Controller Type:** Use the Controller Type pull-down list box to select an available controller type.

**Controller Name:** Use the Controller Name pull-down list box to select an installed controller of the type selected in the Controller Type list box.

**Digital Type:** Use the Digital Type pull-down list box to select whether the reference is an Input or an Output.

**I/O Name:** Use the I/O name pull-down list box to select an available I/O point of the selected Digital Type.
**Editing Enabled**: Use the *Editing Enabled* pull-down list box to specify whether the reference is read-only (*False*) or user-editable (*True*). Inputs and global outputs are not editable.

**Image When Hi**: Click the *Image When Hi* setting to display a dialog box from which you can select a graphic (by file name) to be displayed when the I/O point is high.

**Image When Lo**: Click the *Image When Lo* setting to display a dialog box from which you can select a graphic (by file name) to be displayed when the I/O point is low.

**Top Position**: Use this field to enter the top position (the number of pixels from the top of the screen, under the toolbar) for the digital I/O image on the custom overview screen.

**Left Position**: Use this field to enter the left position (the number of pixels from the left of the screen) for the digital I/O image on the custom overview screen.

**Graphic Properties**

Use the Graphic Properties table, shown in Figure 10-11, to specify an image to be added to your custom overview screen.

![Graphic Properties Table](image)

**FIGURE 10-11** Graphic Properties Table

You can set the following graphic properties:

**Graphic Image**: Click the *Graphic Image* setting to display a dialog box from which you can select an image to add to your custom overview screen.

**Top Position**: Use this field to enter the top position (the number of pixels from the top of the screen, under the toolbar) for the graphic on the custom overview screen.

**Left Position**: Use this field to enter the left position (the number of pixels from the left of the screen) for the graphic on the custom overview screen.
NOTE

If you are planning to use several graphics, we recommend that you use MS Paint or a similar program to add the graphics to a background bitmap which you can then add to the form object. This approach conserves memory and resources and loads faster.

User Variable Properties

Use the User Variable Properties table, shown in Figure 10-12, to set properties for the text used in your user variables. You set up user variables on the Formulas and User Defined Variables screen, as described under “User Defined Variables,” later in this chapter.

FIGURE 10-12 User Variable Properties Table

From the Custom View screen, you can define the following user variable properties:

User Variable #: Use the User Variable # field to enter the number of the user variable for which you want to set properties, then press Enter. The user variable number corresponds to the row number in the user variable spreadsheet on the Formulas and User Defined Variables screen. Refer to “User Variable Spreadsheet,” later in this chapter, for details.

Font Name: Click the Font Name setting to display the Font dialog box from which you can select a font to be used for the user variable text.

Font Size: Click the Font Size setting to display the Font dialog box from which you can select a font size to be used for the user variable text.

Font Bold: Click the Font Bold setting to display the Font dialog box from which you can specify whether the user variable text will be bold (True) or not (False).
Font Italic: Click the Font Italic setting to display the Font dialog box from which you can specify whether the user variable text will be italic (True) or not (False).

Text Color: Click the Text Color setting to display a dialog box from which you can specify a color to be used for the user variable text.

Bkgrnd Color: Click the Bkgrnd Color setting to display a dialog box from which you can specify a background color to be used for the user variable.

Alignment: Use the Alignment pull-down list box to select an alignment for the user variable text: Left, Right, or Center.

Font Rotate (deg): Use the Font Rotate (deg) pull-down list box to select the number of degrees you want the user variable text to be rotated: 0 (horizontal), 90, 180, or 270. Note that only TrueType fonts will rotate.

Bevel Size: Use the Bevel Size field to enter the size of the bevel that surrounds the user variable, then press Enter. If you do not want a bevel, enter 0 in this field.

Bevel Style: Use the Bevel Style pull-down list box to select the style of the bevel that surrounds the user variable: Lowered or Raised.

Height (Pixels): Use the Height field to enter the height (in pixels) for the user variable, then press Enter.

Width (Pixels): Use the Width field to enter the width (in pixels) for the user variable, then press Enter.

Top Position: Use this field to enter the top position (the number of pixels from the top of the screen, under the toolbar) for the user variable on the custom overview screen.

Left Position: Use this field to enter the left position (the number of pixels from the left of the screen) for the user variable on the custom overview screen.

Animation Properties

Use the Animation Properties table, shown in Figure 10-13, to specify how animations will appear in your custom overview screens. Note that the Animations add button is only available if the Anim folder under AnaWin contains animations. Refer to Appendix A for details about using AnaMator to create animations.
FIGURE 10-13 Animation Properties Table

You can set the following animation properties:

**Animation Name:** Use the *Animation Name* pull-down list box to select an available animation to insert and set up.

**Sequence Qty:** This property is automatically set when you select the animation.

**Frame Qty:** This property is automatically set when you select the animation.

**Update:** This property is automatically set when you select the animation, but you can select an available update rate from the *Update* pull-down list box to change this value.

**Auto Repeat:** Use the *Auto Repeat* pull-down list box to choose whether an animation sequence will run only once (*False*) or will automatically repeat (*True*).

**User Variable #:** To make an animation work, you must create a user variable which is a formula that changes values from 1 to the number of sequences in the animation. Animations have multiple (up to 32) segments. Which segment is displayed at any particular time depends on the value of this user variable. For example, when the value of the user variable is 1, segment 1 is shown, when the value of the user variable is 2, segment 2 is shown, and so on. Use the *User Variable #* field to enter the number of the user variable that determines which animation is shown.

**Top Position:** Use this field to enter the top position (the number of pixels from the top of the screen, under the toolbar) for the animation on the custom overview screen.

**Left Position:** Use this field to enter the left position (the number of pixels from the left of the screen) for the animation on the custom overview screen.
**Zoom Properties**

Use the Zoom Properties table, shown in Figure 10-14, to set up a graphical shortcut to another custom overview. When you click the zoom graphic, AnaWin switches to the custom overview you choose here.

![Zoom Properties Table](image)

**FIGURE 10-14 Zoom Properties Table**

You can set the following zoom properties:

- **Graphic Image**: Click the **Graphic Image** setting to display a dialog box from which you can select a graphic for the zoom. Thumbnails of saved custom overview screens appear in the `thumb*.bmp` files in the `Anawin32/bitmaps` folder.

- **Overview Name**: Use the **Overview Name** pull-down list box to select the custom overview screen to which you want AnaWin to switch when you click the zoom graphic.

- **Top Position**: Use this field to enter the top position (the number of pixels from the top of the screen, under the toolbar) for the zoom graphic on the custom overview screen.

- **Left Position**: Use this field to enter the left position (the number of pixels from the left of the screen) for the zoom graphic on the custom overview screen.

**Using the View Manager**

Select **View Manager** from the **File** menu to display the Overview Thumbnails screen, shown in Figure 10-15.

![Overview Thumbnails Screen](image)

**FIGURE 10-15 Overview Thumbnails Screen**
The Overview Thumbnails screen displays thumbnails for up to a total of 32 saved custom overview screens. Each time you save a custom overview screen, AnaWin creates a thumbnail for it.

Up to eight thumbnails appear on the screen at a time. Use the scroll bar to bring additional thumbnails into view. The text boxes below the thumbnails allow you to change the names of the custom overviews associated with the thumbnails.

Right-mouse-click on a thumbnail to display the popup window shown in Figure 10-16.

![FIGURE 10-16 Thumbnail Hot Key / Position Window](image)

The dialog box contains two editable fields:

Use the **Hot Key Assigned** pull-down list box to select a hot key for custom overview associated with the thumbnail. When you press the hot key combination, the custom overview associated with that thumbnail appears.

Use the **Thumbnail Position** pull-down list box to select the position in which the thumbnail will appear on the Overview Thumbnails screen. Typically, you use this feature to order the thumbnails and associated custom overviews by function.

The **Thumbnail Position** field allows you to specify which custom overview you want to appear on startup. If no alarms exist, the custom overview screen associated with the thumbnail in position 1 appears on startup. If an alarm exists, AnaWin displays the Alarm screen on startup.

In addition, **Thumbnail Position** determines which Overview Thumbnail screen is available from the **View** menu in AnaWin.

Click **OK** to close the dialog box and return to the Overview Thumbnails screen.
User Variables

Select **User Variables** from the **Developer** menu to display the Formulas and User Defined Variables screen, shown in Figure 10-17.

From the Formulas and User Defined Variables screen, you can set up the user variables and associated formulas that you want to use with your custom overview screen(s).

**Data Entry Controls**

Use the data entry controls to select a data type, enter raw data of that type, and assign the data to one of the cells on the user variable spreadsheet.

**Number:** Select **Number** to display a data entry field in which you can enter a number, as shown in Figure 10-18. This option is available only for cells A1-D64.

**Formula:** Select **Formula** to display a data entry field in which you can enter a formula consisting of operators and cell references, as shown in Figure 10-19. Refer to Appendix B for details about setting up formulas.
**Controller Value:** Select Controller Value to display a panel of list boxes that allow you to select a controller value, as shown in Figure 10-20. Note that the list boxes that appear on the right side of the panel vary, depending on the type of parameter you select in the bottom left list box.

![Figure 10-20: Selecting Controller Value Data](image)

- Use the top left list box to select a controller.
- Use the bottom left list box to select a type of controller data: *Channel Parameter*, *Global Parameter*, *Digital Input*, or *Digital Output*.

If you select *Channel Parameter*, the following additional list boxes appear:
- **Channel**: Use the *Channel* pull-down list box to select a channel.
- **Parameter**: Use the *Parameter* pull-down list box to select a specific parameter for the selected channel.

If you select *Global Parameter*, the following additional list box appears:
- **Parameter**: Use the *Parameter* pull-down list box to select a global parameter for the selected controller.

If you select *Digital Input*, the following additional list box appears:
- **Input**: Use the *Input* pull-down list box to select an available input point.

If you select *Digital Output*, the following additional list box appears:
- **Output**: Use the *Output* pull-down list box to select an available output point.

**Assign Entry To <cell>**: Click the *Assign Entry To <cell>* button to assign the data you entered or selected using the *Number*, *Formula*, or *Controller Value* option to the cell selected in the user variable spreadsheet.
**User Variable Spreadsheet**

Each row in the spreadsheet represents a different user variable. The row numbers correspond to the user variable numbers that you specify when you are adding a user variable to a custom overview screen or using the user variable as a reference for an animation. Refer to “User Variable Properties,” earlier in this chapter, for details about formatting the text for user variables. Columns A, B, C, and D contain the raw data from which you will construct the user variable.

**Creating User Variables**

Follow these steps to create user variables:

1. Assign data to cells in columns A-D as follows:
   a. Select the cell to which you want to assign the data by clicking on it in the spreadsheet. The Assign Entry To <cell> button now indicates that data will be assigned to the selected cell.
   b. From the data entry controls, select the option corresponding to the data type you want to enter: Number, Formula, or Controller Value.
   c. Enter data of the selected type. Refer to the descriptions of the specific options, above, for details.
   d. Click Assign Entry To <cell> to assign the data to the selected cell.

2. Use the Formula/User Var column to enter a formula for the user variable based on the number and calculations in the raw data cells (columns A, B, C, and D).

3. Use the User Var Name column to enter a name for the user variable.

4. Ensure that Updates Enabled is selected. This option must be selected in order for AnaWin to calculate user variables.

5. Click Save to save the user variables you defined in the spreadsheet.
Working with System Alarms

This Chapter explains how to display and acknowledge AnaWin system alarms.

Interpreting the Alarm Screen

AnaWin screens include an Alarm button that displays the Alarm screen, shown in Figure 11-1. This screen displays all current and historical system alarms. In addition, you can select the Auto Alarm View on the Preferences screen to cause AnaWin to automatically switch to the Alarm screen when an alarm condition exists.
Working with System Alarms

Date/Time

The Date/Time column displays the date and time each alarm event occurred.

Group Name

The Group/Name column displays the name of the group in which the alarm occurred.

Channel Name

The Channel Name column displays the channel to which the alarm applies.

Alarm Message

The Alarm Message column displays an alarm message associated with the alarm type. You define these messages on the Alarm tab in the Channel Setup screen. Refer to "Channel Setup Tabs," in Chapter 5 for details.

Alarm Type

The Type column displays the type of controller alarm (symbols are identical to controller symbols). Table 11-12 defines the alarm type symbols.

FIGURE 11-1 Alarm Screen
TABLE 11-1  Alarm Types

<table>
<thead>
<tr>
<th>Alarm Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FS</td>
<td>Thermocouple break</td>
</tr>
<tr>
<td>HP</td>
<td>High Process Alarm</td>
</tr>
<tr>
<td>HD</td>
<td>High Deviation Alarm</td>
</tr>
<tr>
<td>LD</td>
<td>Low Deviation Alarm</td>
</tr>
<tr>
<td>LP</td>
<td>Low Process Alarm</td>
</tr>
</tbody>
</table>

### Alarm Symbol

The Alarm column displays the symbol for the alarm. Table 11-2 defines the alarm symbols.

TABLE 11-2  Alarm Symbols

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="green.png" alt="Green" /></td>
<td>(Green) Indicates that the process is within its deviation band.</td>
</tr>
<tr>
<td><img src="yellow.png" alt="Yellow" /></td>
<td>(Yellow) Indicates that the process is outside the deviation band.</td>
</tr>
<tr>
<td><img src="red.png" alt="Red" /></td>
<td>(Red) A High or Low Process Alarm is unacknowledged.</td>
</tr>
<tr>
<td><img src="grey.png" alt="Grey" /></td>
<td>(Grey) Alarm has been acknowledged.</td>
</tr>
</tbody>
</table>

### Clear View

Click *Clearview* to clear the alarms listed on the Alarm screen. Note that if an alarm condition continues, the references for that alarm will continue to appear in the columns.

### Print (Alarms)

Click Print to display the print dialog for printing the Alarm screen.
Acknowledging Alarms

To acknowledge a single alarm, follow these steps:

1. Select the alarm, by clicking on it in the list. The alarm is displayed in the Next Unacknowledged Alarm field.

2. Click Acknowledge This Alarm.

To acknowledge all alarms, click Ack All Alarms.
Using AnaMator

This appendix explains how to use the AnaMator application to create animations which you can add to your AnaWin custom overview screens.

AnaMator Overview

AnaMator allows you to define animation objects using bitmap files generated by third-party applications. Each animation object is comprised of a series of up to 32 sequences, each of which consists of a series of up to 32 frames. The following restrictions apply:

- All bitmaps in an animation object must be the same size and an even number of pixels in each dimension.
- Each sequence in an animation object must have the same number of frames.

Each animation object is tied to a specific user-defined variable. When the variable = 1, then sequence 1 will play. When the variable = n, then sequence n will play. Refer to “User Variables,” in Chapter 10, for details about setting up user-defined variables.

You can define an unlimited number of animation objects. In addition, AnaWin does not limit the number of animation objects you can use on each custom overview screen; however, with complex custom overviews and large animations, CPU speed and memory resources may limit the number of animations you can use. Refer to “Design Custom Overview,” in Chapter 10, for details about adding your animations to custom overview screens.
Opening a New Animation

When you launch AnaMator from the AnaWin program group, the AnaMator Setup screen, shown in Figure A-1, appears with a new animation open.

Notice that the title bar for the Setup screen is blank until you save a new animation or open an existing animation.

To create your new animation, use the Animation Setup and Frame Setup features, as described later in this chapter, under "Editing Animations." When you save the animation, its file name will appear in the Setup screen's title bar.

If you have opened an existing animation, as described below under "Opening an Existing Animation," select New from the File menu to open a new animation.

Opening an Existing Animation

To open an existing animation, follow these steps:

1. From the File menu, select Open. The Open window, shown in Figure A-2, appears to the right of the Setup screen.
2. Select a file in the Open window by clicking on its name.
3. Click Open to open the selected animation. The Open window closes, and the file name for the animation you selected now appears in the Setup screen's title bar. You can now use the Animation Setup and Frame Setup features to modify the animation, as described below, under "Editing Animations."
Using AnaMator

Edited Animations

The AnaMator Setup screen includes two setup options—Animation Setup and Frame Setup. These options display setup controls that allow you to specify parameters for the animation as a whole and to assign bitmap files to the individual frames that comprise the animation.

Animation Setup

If you select Animation Setup, the AnaMator Animation Setup screen shown earlier, in Figure A-1, appears. Use this screen to set parameters for the animation as a whole. The AnaMator Animation Setup screen includes the following controls:

Number of Sequences

Drag the indicator to set the number of sequences in the animation. The number you set appears in the display field.

Number of Frames in each Sequence

Drag the indicator to set the number of frames per sequence in the animation. The number you set appears in the display field.

Update Speed

Drag the indicator to set the update speed (in seconds) for the animation. The number you set appears in the display field.

Physical Memory (RAM) Used

The Physical Memory Used field lists the amount of memory used by the animation.
**Status Bar**

The status bar at the bottom of the screen displays the status of the AnaMator program. The *Ready* status means that AnaMator is ready for you to use.

**Frame Setup**

If you select *Frame Setup*, the AnaMator Frame Setup screen, shown in Figure A-3, appears. You use this screen to create an animation by assigning bitmap files to each frame.

To create an animation, follow these steps:
1. Use the *Sequence* and *Frame* indicators to select the frame to which you want to assign a bitmap.
2. Click *Change* to display a standard Windows 95 Open File dialog box.
3. Select a bitmap file for that frame. AnaMator copies the bitmap file and assigns it an unchangeable animation file name.
4. Repeat steps 1-3 to assign bitmaps to the other frames in the animation.

![Figure A-3: AnaMator Frame Setup Screen](image)

**NOTE**

If you want the animation to repeat automatically, select *Auto Repeat* from the *Options* menu.
The Frame Setup screen includes the following controls:

**Sequence**

Drag the indicator to the position corresponding to the number of the sequence you want to edit. The sequence number you select appears in the display field.

**Frame**

Drag the indicator to the position corresponding to the number of the frame you want to edit. The frame number you select appears in the display field. If a frame exists for the selected frame number, the Frame window appears to the right of the Frame Setup screen, as shown in Figure A-4. This window displays the selected frame. The notation in the title bar indicates the sequence and frame numbers. For example, 1:1 indicates sequence 1, frame 1.

**Original file name**

The *Original file name* field displays the original bitmap file name. AnaMator copies your original file to the anim directory under Anawin32 to ensure it is available for playback.

**Animation file name**

The *Animation file name* field displays the bitmap file name for the animation. This is the file name that AnaMator creates when it copies the original bitmap file. It reflects the sequence number / frame number combination for which the bitmap is being used. For example, file name *s1f1.bmp* represents the bitmap file for sequence 1, frame 1.
Change

Click *Change* to open a standard Windows95 Open File dialog box, from which you can select a bitmap file to use for the frame.

Status Bar

The status bar at the bottom of the screen displays the status of the AnaMator program. The *Ready* status means AnaMator is ready for you to use.

Saving and Removing Animations

Use the options on the *File* menu to save and remove animations:
- To save an animation, select *Save* from the *File* menu.
- To save an animation under a new name, follow these steps:
  1. From the *File* menu, select *Save As*.
  2. Enter or select the file name under which you want to save the animation.
  3. Click *Save* to save the animation under the new name.

To remove an animation, follow these steps:
  1. From the *File* menu, select *Remove*.
  2. Select the file name for the animation you want to remove.
  3. Click *Remove* to remove the selected animation.

Playing Back Animations

To play the current sequence of an animation, select *Play Current Sequence* from the *Options* menu. A window, in which you can view the animation sequence running, appears to the right of the AnaMator Setup window, as shown in Figure A-5. Click the standard Close button in the upper right corner of the window to stop the sequence.
FIGURE A-5  AnaMator Setup Screen with Sequence Running Window
Using AnaMator
**User Variable Operators and Functions**

This appendix lists the operators and functions that may be used on the Formulas and User Defined Variables spreadsheet.

### Available Operators

The following table lists the operations available as math expressions.

<table>
<thead>
<tr>
<th>Operator</th>
<th>Description</th>
<th>Literal / Literal</th>
<th>Cell Ref / Literal</th>
<th>Cell Ref / Cell Ref</th>
</tr>
</thead>
<tbody>
<tr>
<td>+</td>
<td>Addition</td>
<td>2 + 2</td>
<td>A1 + 2</td>
<td>A1 + B2</td>
</tr>
<tr>
<td>^</td>
<td>Exponentiation</td>
<td>2 ^ 2</td>
<td>A1 ^ 2</td>
<td>A1 ^ B2</td>
</tr>
<tr>
<td>/</td>
<td>Division</td>
<td>2 / 2</td>
<td>A1 / 2</td>
<td>A1 / B2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Logical OR</td>
<td>2</td>
<td>2</td>
</tr>
<tr>
<td>:</td>
<td>Creates a range</td>
<td>2</td>
<td>2</td>
<td>A1 : B2</td>
</tr>
<tr>
<td>#</td>
<td>Wild card</td>
<td></td>
<td>A #</td>
<td>2</td>
</tr>
</tbody>
</table>
NOTE

The exponentiation operator cannot be used to take roots of negative numbers. Do not attempt to raise a negative number to a power between zero and one. Do not use the exponentiation operator to raise a user variable that may become negative to a power between zero and one.

Available Functions

The following functions are available as math expressions. The letter A represents a relational expression, for example, A1 > B1. The letters B and C represent references to cell or mathematical expressions that contain cell references. The letter D represents the amount of precision.

ABS(B): The absolute value of the cell is returned.

ADD(A,B): Adds the two elements.

IF(A,B,C): If A is nonzero, then B is returned. If A is zero, then C is returned. A can contain one of the relational operators: greater than (>), less than (<), equal to (=), or not equal to (!).

ISEMPTY(B): If B is empty then a 1 is returned. If B is not empty then a zero is returned.

MAX(A,B, . . .): Returns the maximum value of all arguments. Accepts a variable number of arguments. Each argument can be a cell range, a float value, or an integer value.

MIN(A,B, . . .): Returns the minimum value of all arguments. Accepts a variable number of arguments. Each argument can be a cell range, a float value, or an integer value.

NEG(B): Changes the sign of the value. For example, NEG(15) = 15.

NOT(B): If B is zero then a 1 is returned. If B is not zero then a zero is returned.

ROUNDUP(B,D): Rounds the value up to the next whole number, using the specified number of decimal places (D). A zero can be used for no decimal places. Negative precision specifies tenths, hundredths, etc.

ROUND(B,D): Rounds the value to the nearest whole number, using the specified number of decimal places (D). A zero can be used for no decimal places. Negative precision specifies tenths, hundredths, etc.
**SUM(B,C,...)**: Sums cells or blocks. Accepts a variable number of arguments. Each argument can be a cell range, a float value, or an integer value.

**TRUNCATE(B,D)**: Rounds the value down to the next whole number, using the specified number of decimal places (D). A zero can be used for no decimal places. Negative precision specifies tenths, hundredths, etc.
User Variable Operators and Functions
AnaWin OLE Server

This appendix describes the AnaWin OLE Server. AnaWin 2.0 fully supports the interchange of data with other Windows95 applications as defined by OLE2.

AnaWin OLE Server Features

An OLE client may do any of the following:

- Read the value for any global or channel-based parameter for all controllers on the bus.
- Set the value of control mode (manual, auto, or tune), setpoint, and control output for all controllers on the bus.
- Get a list of available recipes.
- Tell AnaWin to download a recipe.

OLE Server Exposed Methods

All exposed methods return an integer value indicating the outcome of the method. A basic file that declares constants for all possible return values is available for inclusion in visual basic projects. The possible return values are listed at the end of this appendix.

The following are declarations for all exposed methods:
Getting Data

GetChannelDataValues(Address as Integer, ParmNum as Integer, StartChan as Integer, NumValues as Integer, Values as Variant)

GetGlobalDataValue(Address as Integer, ParmNum as Integer, Value as Variant)

Used to obtain channel data values for one or more channels or one global data value from a single controller on the bus. By definition, a global data item only has one value for the entire controller and thus no StartChan or NumValues.

Address: The modbus address of the desired controller.

ParmNum: The parameter number of the requested data.

StartChan: The first channel for which data is requested.

NumValues: The number of channels for which data is requested.

Values: An array of values containing the requested data is returned in this variant. The data type of the value is dependent on the ParmNum passed.

Value: This is the same as Values, only it is a single value instead of an array.

A list of valid channel and global parameters is provided at the end of this appendix.

Setting Data

SetChannelDataValues(Address as Integer, ParmNum as Integer, StartChan as Integer, NumValues as Integer, Values as Variant)

Used to set channel data values on a single controller. Note that only Setpoint, Control, Heat (Primary) Output, and Cool (Secondary) Output are accepted for ParmNum. All parameters are as described above except that the caller fills Values with an array of values prior to calling the method.

AnaWin’s server checks the validity of the values passed. If all data is valid, SetChannelDataValues returns AWOK and attempts to send the data to the controller. However, it is possible that the controller can reject the download. The actual result of the download can be obtained by calling the RecipeLoadStatus method described below.
Getting Parameter Names

GetChannelParameterName(Address as Integer, ParmNum as Integer, Value as Variant)

GetGlobalParameterName(Address as Integer, ParmNum as Integer, Value as Variant)

Used to get the strings displayed in AnaWin for the specified controller and parameter. Value is filled by the server and will contain a string of 20 characters or less.

Getting Recipe Names

GetRecipeList(rcpList as Variant, Optional GroupNum as Variant)

Use to obtain a list of stored recipes. The server fills rcpList with an array of strings (each containing 20 or fewer characters). For systems that use loop grouping, one call must be made to get the list for each group. GroupNum should be omitted for systems that do not use loop grouping. If GroupNum is omitted on systems that use loop grouping, the recipe names for group 0 are returned. If there are no recipes stored for the specified GroupNum, the return value is AWNoRecipes(8).

Downloading Recipes

LoadRecipe(RecipeName as String, Optional GroupNum as Variant)

Used to load a recipe to the controller(s). Note that a recipe may span controllers. As described above, for systems that use loop grouping, GroupNum should be specified. If GroupNum is omitted on such systems, group 0 is assumed.

When LoadRecipe is called, it returns immediately. If the request does not pass validity checks, the appropriate error response is returned and the recipe is not downloaded. If the request passes the validity checks, the recipe download attempt is begun. The actual result of the attempted download can be obtained by calling the RecipeLoadStatus method described below.

Getting Download Status

RecipeLoadStatus()

Returns the status of the most recent recipe download or GetChannelDataValues. Possible return values are:

AWDownloadInProgress (9): Download not yet complete.
AWNoDownloadRequested (11): No download has been requested or the status of the latest download has already been read.

AWDownloadSuccessful (12): Download successful.

AWDownloadFailed (3): Download failed.

Once the status of a download has been obtained, subsequent calls to RecipeLoadStatus will return AWNoDownloadInRequested (11).

Registering as a Client

RegisterAsClient(clientObj as Object)

UnRegisterAsClient(Clientkey as Integer)

The AnaWin OLE server allows (and encourages) clients to register themselves so that AnaWin can keep track of them. This allows AnaWin to notify clients when a local user shuts it down. Once the local user has shut AnaWin down, AnaWin will no longer respond to client requests with meaningful data. All queries will be responded to with the value AWShutDown (1). However, AnaWin cannot completely shut down until all references are relinquished.

The RegisterAsClient and UnRegisterAsClient methods allow AnaWin to notify all clients when a user has shut it down, so they can relinquish their references to the server and it can shut down. Note that if a user shuts down AnaWin, it cannot be restarted until all clients have closed their references to it.

To use the registration facility, the client must pass an object that exposes a ShutDown method that AnaWin may call when it is shut down to the RegisterAsClient function. RegisterAsClient returns a long integer value that the client can save as its client ID. If the client wishes to shut down before AnaWin shuts down, it should call the UnRegisterAsClient method, passing the client ID value, then close its reference to the server.

The client’s shutdown method should immediately close its reference to the server.

WARNING

The client should not call UnRegisterAsClient from its ShutDown method, as this will cause an OLE deadlock situation where each process is waiting for the other to return from its message call.
OLE Server Constant Values

The following are the OLE server constant values that can be returned from calls to the exposed methods.

**AWOK (0):** Returned by all functions if they are successful.

**AWSHutDown (1):** Returned by all functions if a local user has shut Anawin down.

**AWNNotCommunicating (2):** Returned by all functions if AnaWin is not able to communicate to the controllers on the bus.

**AWInvalidParameter (3):** Returned by the Get and Set data values and the get parameters names functions if an invalid parameter number is passed to them.

**AWInvalidAddress (4):** Returned by any function that accepts a modbus address, when an address that has no controller assigned to it is passed.

**AWInvalidChannel (5):** Returned by any function that deals with channel data when a channel number is passed to it that is less than zero or greater than the number of channels that the controller at the passed address has.

**AWOutOfRange (6):** Returned by SetChannelDataValues when a value is passed in the values array that is invalid for the passed ParmNum.

**AWInvalidGroup (7):** Returned by the recipe functions if the GroupNum specifies a group that does not exist.

**AWNoRecipes (8):** Returned by the GetRecipeList if there are no recipes stored for the specified GroupNum.

**AWDownloadInProgress (9)**

**AWNonExistentRecipe (10)**

**AWNoDownloadRequested (11)**

**AWDownloadSuccessful (12)**

**AWDownloadFailed (13)**

These are the possible return values for RecipeLoadStatus. AWDownloadInProgress may also be returned by the LoadRecipe function, indicating that another download is already in progress and the client must wait until it is done before it downloads another.

**AWInconsistentArguments (14):** Returned by SetChannelDataValues if NumVals does not equal the size of the values array.
**AWServerBusy (15):** Returned by SetChannelDataValues if the server is busy downloading values requested by the user or another client. If this is received, the client should try again later.

**AWStartingUp (16):** When AnaWin starts up, it reads up the data tables for all attached controllers. This can take several minutes, depending on how many controllers are on the bus. During the startup process, AnaWin responds to all data queries and download requests with AWStartingUp. The client should wait until the startup process is complete before sending or requesting data.

## CLS/MLS Channel Parameters

The following table describes the valid channel parameters.

<table>
<thead>
<tr>
<th>Parameter Number</th>
<th>Parameter Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Input Type</td>
</tr>
<tr>
<td>1</td>
<td>Heat Prop Band</td>
</tr>
<tr>
<td>2</td>
<td>Heat Integral</td>
</tr>
<tr>
<td>3</td>
<td>Heat Derivative</td>
</tr>
<tr>
<td>4</td>
<td>Heat Type</td>
</tr>
<tr>
<td>5</td>
<td>Control Mode</td>
</tr>
<tr>
<td>6</td>
<td>Heat Enable</td>
</tr>
<tr>
<td>7</td>
<td>Heat Action</td>
</tr>
<tr>
<td>8</td>
<td>Setpoint</td>
</tr>
<tr>
<td>9</td>
<td>Process Variable</td>
</tr>
<tr>
<td>10</td>
<td>Heat PID Filter</td>
</tr>
<tr>
<td>11</td>
<td>Heat PID Output %</td>
</tr>
<tr>
<td>12</td>
<td>Hi Process Alarm</td>
</tr>
<tr>
<td>13</td>
<td>Lo Process Alarm</td>
</tr>
<tr>
<td>14</td>
<td>Deviation Alarm</td>
</tr>
<tr>
<td>15</td>
<td>Alarm Deadband</td>
</tr>
<tr>
<td>16</td>
<td>Stpt Src Frm Chn</td>
</tr>
<tr>
<td>17</td>
<td>InputRange Hi PV</td>
</tr>
<tr>
<td>18</td>
<td>InputRange Lo PV</td>
</tr>
<tr>
<td>19</td>
<td>Input Decimals</td>
</tr>
<tr>
<td>20</td>
<td>Heat TP Time</td>
</tr>
<tr>
<td>21</td>
<td>Input Eng. Units</td>
</tr>
<tr>
<td>22</td>
<td>Inp Hi%Fullscale</td>
</tr>
<tr>
<td>23</td>
<td>Inp Lo%Fullscale</td>
</tr>
<tr>
<td>24</td>
<td>Heat/Cool Spread</td>
</tr>
<tr>
<td>25</td>
<td>HiProc Alm Out#</td>
</tr>
<tr>
<td></td>
<td>Choice</td>
</tr>
<tr>
<td>---</td>
<td>------------------------------</td>
</tr>
<tr>
<td>26</td>
<td>LoProc Alm Out#</td>
</tr>
<tr>
<td>27</td>
<td>HiDev Alm Out#</td>
</tr>
<tr>
<td>28</td>
<td>LoDev Alm Out#</td>
</tr>
<tr>
<td>29</td>
<td>HeatOutputLimit%</td>
</tr>
<tr>
<td>30</td>
<td>Heat OutLim Time</td>
</tr>
<tr>
<td>31</td>
<td>Heat Override %</td>
</tr>
<tr>
<td>32</td>
<td>Cool Override %</td>
</tr>
<tr>
<td>33</td>
<td>Heat Non-Linear</td>
</tr>
<tr>
<td>34</td>
<td>Heat SDAC Mode</td>
</tr>
<tr>
<td>35</td>
<td>Heat Lo Val SDAC</td>
</tr>
<tr>
<td>36</td>
<td>Heat Hi Val SDAC</td>
</tr>
<tr>
<td>37</td>
<td>Input Filter</td>
</tr>
<tr>
<td>38</td>
<td>Alarm Delay</td>
</tr>
<tr>
<td>39</td>
<td>Cool Prop Band</td>
</tr>
<tr>
<td>40</td>
<td>Cool Derivative</td>
</tr>
<tr>
<td>41</td>
<td>Cool Integral</td>
</tr>
<tr>
<td>42</td>
<td>Cool Type</td>
</tr>
<tr>
<td>43</td>
<td>Cool TP Time</td>
</tr>
<tr>
<td>44</td>
<td>Cool Enable</td>
</tr>
<tr>
<td>45</td>
<td>Cool Action</td>
</tr>
<tr>
<td>46</td>
<td>Cool PID Filter</td>
</tr>
<tr>
<td>47</td>
<td>Cool PID Output%</td>
</tr>
<tr>
<td>48</td>
<td>CoolOutputLimit%</td>
</tr>
<tr>
<td>49</td>
<td>Cool OutLim Time</td>
</tr>
<tr>
<td>50</td>
<td>Cool Non-Linear</td>
</tr>
<tr>
<td>51</td>
<td>Cool SDAC Mode</td>
</tr>
<tr>
<td>52</td>
<td>Cool Lo Val SDAC</td>
</tr>
<tr>
<td>53</td>
<td>Cool Hi Val SDAC</td>
</tr>
<tr>
<td>54</td>
<td>Alarm Control</td>
</tr>
<tr>
<td>55</td>
<td>LoProc Alarm Type</td>
</tr>
<tr>
<td>56</td>
<td>HiDev Alarm Type</td>
</tr>
<tr>
<td>57</td>
<td>LoDev Alarm Type</td>
</tr>
<tr>
<td>58</td>
<td>Alarm Status</td>
</tr>
<tr>
<td>59</td>
<td>Alarm Enable</td>
</tr>
<tr>
<td>60</td>
<td>Alarm Mask</td>
</tr>
<tr>
<td>61</td>
<td>Alarm Ack</td>
</tr>
</tbody>
</table>
## CLS/MLS Global Parameters

The following table describes the valid global parameters.

<table>
<thead>
<tr>
<th>Parameter Number</th>
<th>Parameter Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Ambient Reading</td>
</tr>
<tr>
<td>1</td>
<td>Pulse Sample Time</td>
</tr>
<tr>
<td>2</td>
<td>Zero Calibrate</td>
</tr>
<tr>
<td>3</td>
<td>Full Scale Cal</td>
</tr>
<tr>
<td>4</td>
<td>Battery Stat</td>
</tr>
<tr>
<td>5</td>
<td>Init Start Stat</td>
</tr>
<tr>
<td>6</td>
<td>AIM Stat</td>
</tr>
<tr>
<td>7</td>
<td>Ambient Stat</td>
</tr>
<tr>
<td>8</td>
<td>Zero Cal Stat</td>
</tr>
<tr>
<td>9</td>
<td>Full Scale Stat</td>
</tr>
<tr>
<td>10</td>
<td>Alarms Delayed</td>
</tr>
<tr>
<td>11</td>
<td>#CLS Chans</td>
</tr>
<tr>
<td>12</td>
<td>PowerUp State</td>
</tr>
<tr>
<td>13</td>
<td>Operator Keys</td>
</tr>
<tr>
<td>14</td>
<td>System Hertz</td>
</tr>
<tr>
<td>15</td>
<td>Dig Alm Pol</td>
</tr>
<tr>
<td>16</td>
<td>EPROM Ver</td>
</tr>
<tr>
<td>17</td>
<td>MLS Chans</td>
</tr>
<tr>
<td>18</td>
<td>Extruder Opt</td>
</tr>
<tr>
<td>19</td>
<td>Start Delay</td>
</tr>
<tr>
<td>20</td>
<td>Save To Job</td>
</tr>
<tr>
<td>21</td>
<td>Forced DigOut</td>
</tr>
</tbody>
</table>
Glossary

A

AC
See Alternating Current.

AC Line Frequency
The frequency of the AC power line measured in Hertz (Hz), usually 50 or 60 Hz.

Accuracy
Closeness between the value indicated by a measuring instrument and a physical constant or known standards.

Action
The response of an output when the process variable is changed. See also Direct action, Reverse action.

Address
A numerical identifier for a controller when used in computer communications.

Alarm
A signal that indicates that the process has exceeded or fallen below a certain range around the setpoint. For example, an alarm may indicate that a process is too hot or too cold. See also:
- Deviation Alarm
- Failed Sensor Alarm
- Global Alarm
- High Deviation Alarm
- High Process Alarm
- Loop Alarm
- Low Deviation Alarm
- Low Process Alarm

Alarm Delay
The lag time before an alarm is activated.

Alternating Current (AC)
An electric current that reverses at regular intervals, and alternates positive and negative values.

Ambient Temperature
The temperature of the air or other medium that surrounds the components of a thermal system.

American Wire Gauge (AWG)
A standard of the dimensional characteristics of wire used to conduct electrical current or signals. AWG is identical to the Brown and Sharpe (B & S) wire gauge.

Ammeter
An instrument that measures the magnitude of an electric current.

Ampere (Amp)
A unit that defines the rate of flow of electricity (current) in the circuit. Units are one coulomb (6.25 x 1018 electrons) per second.

Analog Output
A continuously variable signal that is used to represent a value, such as the process value or setpoint value. Typical hardware configurations are 0-20mA, 4-20mA or 0-5 V dc.

Automatic Mode
A feature that allows the controller to set PID control outputs in response to the Process Variable (PV) and the setpoint.

Autotune
A feature that automatically sets temperature control PID values to match a particular thermal system.

B

Bandwidth
A symmetrical region above and below the setpoint in which proportional control occurs.

Baud Rate
The rate of information transfer in serial communications, measured in bits per second.
Block Check Character (BCC)
A serial communications error checking method. An acceptable method for most applications, BCC is the default method. See CRC.

Bumpless Transfer
A smooth transition from Auto (closed loop) to Manual (open loop) operation. The control output does not change during the transfer.

Calibration
The comparison of a measuring device (an unknown) against an equal or better standard.

Celsius (Centigrade)
Formerly known as Centigrade. A temperature scale in which water freezes at 0°C and boils at 100°C at standard atmospheric pressure. The formula for conversion to the Fahrenheit scale is: °F=(1.8×°C)+32.

Central Processing Unit (CPU)
The unit of a computing system that includes the circuits controlling the interpretation of instructions and their execution.

Circuit
Any closed path for electrical current. A configuration of electrically or electromagnetically-connected components or devices.

Closed Loop
A control system that uses a sensor to measure a process variable and makes decisions based on that feedback.

Cold Junction
Connection point between thermocouple metals and the electronic instrument.

Common Mode Rejection Ratio
The ability of an instrument to reject electrical noise, with relation to ground, from a common voltage. Usually expressed in decibels (dB).

Communications
The use of digital computer messages to link components. See Serial Communications. See Baud Rate.

Control Action
The response of the PID control output relative to the error between the process variable and the setpoint. For reverse action (usually heating), as the process decreases below the setpoint the output increases. For direct action (usually cooling), as the process increases above the setpoint, the output increases.

Control Mode
The type of action that a controller uses. For example, On/Off, time proportioning, PID, Automatic or manual, and combinations of these.

Current
The rate of flow of electricity. The unit of measure is the ampere (A). 1 ampere = 1 coulomb per second.

Cycle Time
The time required for a controller to complete one on-off-on cycle. It is usually expressed in seconds.

Cyclic Redundancy Check (CRC)
An error checking method in communications. It provides a high level of data security but is more difficult to implement than Block Check Character (BCC). See Block Check Character.

Data Logging
A method of recording a process variable over a period of time. Used to review process performance.

Deadband
The range through which a variation of the input produces no noticeable change in the output. In the deadband, specific conditions can be placed on control output actions. Operators select the deadband. It is usually above the heating proportional band and below the cooling proportional band.
Default Parameters
  The programmed instructions that are permanently stored in the microprocessor software.

Derivative Control (D)
  The last term in the PID algorithm. Action that anticipated the rate of change of the process, and compensates to minimize overshoot and undershoot. Derivative control is an instantaneous change of the control output in the same direction as the proportional error. This is caused by a change in the process variable (PV) that decreases over the time of the derivative (TD). The TD is in units of seconds.

Deutsche Industrial Norms (DIN)
  A set of technical, scientific and dimensional standards developed in Germany. Many DIN standards have worldwide recognition.

Deviation Alarm
  Warns that a process has exceeded or fallen below a certain range around the setpoint.

Digital to Analog Converter (DAC)
  A device that converts a numerical input signal to a signal that is proportional to the input in some way.

Direct Action
  An output control action in which an increase in the process variable, causes an increase in the output. Cooling applications usually use direct action.

Direct Current (DC)
  A n electric current that flows in one direction.

Distributed Zero Crossing (DZC)
  A form of digital output control. Similar to burst fire.

Earth Ground
  A metal rod, usually copper, that provides an electrical path to the earth, to prevent or reduce the risk of electrical shock.

Electrical Noise
  See Noise.

Electromagnetic Interference (EMI)
  Electrical and magnetic noise imposed on a system. There are many possible causes, such as switching ac power on inside the sine wave. EMI can interfere with the operation of controls and other devices.

Electrical-Mechanical Relays
  See Relay, electromechanical.

Emissivity
  The ratio of radiation emitted from a surface compared to radiation emitted from a blackbody at the same temperature.

Engineering Units
  Selectable units of measure, such as degrees Celsius and Fahrenheit, pounds per square inch, newtons per meter, gallons per minute, liters per minute, cubic feet per minute or cubic meters per minute.

EPROM
  Erasable Programmable, Read-Only Memory inside the controller.

Error
  The difference between the correct or desired value and the actual value.

Fahrenheit
  The temperature scale that sets the freezing point of water at 32°F and its boiling point at 212°F at standard atmospheric pressure. The formula for conversion to Celsius is: °C =5/9 (°F-32°F).
Failed Sensor Alarm
Warns that an input sensor no longer produces a valid signal. For example, when there are thermocouple breaks, infrared problems or resistance temperature detector (RTD) open or short failures.

Filter
Filters are used to handle various electrical noise problems.

Digital Filter (DF) — A filter that allows the response of a system when inputs change unrealistically or too fast. Equivalent to a standard resistor-capacitor (RC) filter

Digital Adaptive Filter — A filter that rejects high frequency input signal noise (noise spikes).

Heat/Cool Output Filter — A filter that slows the change in the response of the heat or cool output. The output responds to a step change by going to approximately 2/3 its final value within the numbers of scans that are set.

Frequency
The number of cycles over a specified period of time, usually measured in cycles per second. Also referred to as Hertz (Hz). The reciprocal is called the period.

Gain
The amount of amplification used in an electrical circuit. Gain can also refer to the Proportional (P) mode of PID.

Global Alarm
A alarm associated with a global digital output that is cleared directly from a controller or through a user interface.

Global Digital Outputs
A pre-selected digital output for each specific alarm that alerts the operator to shut down critical processes when an alarm condition occurs.

Ground
A n electrical line with the same electrical potential as the surrounding earth. Electrical systems are usually grounded to protect people and equipment from shocks due to malfunctions. Also referred to a “safety ground.”

Hertz(Hz)
Frequency, measured in cycles per second.

High Deviation Alarm
Warns that the process is above setpoint, but below the high process variable. It can be used as either an alarm or control function.

High Power
(As defined by ANAFAZE) Any voltage above 24 VAC or Vdc and any current level above 50 mA ac or mAdc.

High Process Alarm
A signal that is tied to a set maximum value that can be used as either an alarm or control function.

High Process Variable (PV)
See Process Variable (PV).

High Reading
A n input level that corresponds to the high process value. For linear inputs, the high reading is a percentage of the full scale input range. For pulse inputs, the high reading is expressed in cycles per second (Hz).

Infrared
A region of the electromagnetic spectrum with wavelengths ranging from one to 1,000 microns. These wavelengths are most suited for radiant heating and infrared (noncontact) temperature sensing.

Input
Process variable information that is supplied to the instrument.
**Input Scaling**
The ability to scale input readings (readings in percent of full scale) to the engineering units of the process variable.

**Input Type**
The signal type that is connected to an input, such as thermocouple, RTD, linear or process.

**Integral Control (I)**
Control action that automatically eliminates offset, or droop, between setpoint and actual process temperature.
See Auto-reset.

**Job**
A set of operating conditions for a process that can be stored and recalled in a controller’s memory. also called a Recipe.

**Junction**
The point where two dissimilar metal conductors join to form a thermocouple.

**Lag**
The delay between the output of a signal and the response of the instrument to which the signal is sent.

**Linear Input**
A process input that represents a straight line function.

**Linearity**
The deviation in response from an expected or theoretical straight line value for instruments and transducers. also called Linearity Error.

**Liquid Crystal Display (LCD)**
A type of digital display made of a material that changes reflectance or transmittance when an electrical field is applied to it.

**Load**
The electrical demand of a process, expressed in power (watts), current (amps), or resistance (ohms). The item or substance that is to be heated or cooled.

**Loop Alarm**
Any alarm system that includes high and low process, deviation band, deadband, digital outputs, and auxiliary control outputs.

**Low Deviation Alarm**
Warns that the process is below the setpoint, but above the low process variable. It can be used as either an alarm or control function.

**Low Process Alarm**
A signal that is tied to a set minimum value that can be used as either an alarm or control function.

**Low Reading**
An input level corresponding to the low process value. For linear inputs, the low reading is a percentage of the full scale input range. For pulse inputs, the low reading is expressed in cycles per second (Hz).

**M**

**Manual Mode**
A selectable mode that has no automatic control aspects. The operator sets output levels.

**Manual Reset**
See Reset.

**Milliampere (mA)**
One thousandth of an ampere.

**N**

**No Key Reset**
A method for resetting the controller's memory (for instance, after an EPROM change).

**Noise**
Unwanted electrical signals that usually produce signal interference in sensors and sensor circuits. See Electromagnetic Interference.
**Glossary**

**Noise Suppression**
The use of components to reduce electrical interference that is caused by making or breaking electrical contact, or by inductors.

**Non Linear**
Through ANAFAZE software, the Non Linear field sets the system to linear control, or to one of two non linear control options. Input 0 for Linear, 1 or 2 for non linear.

**Offset**
The difference in temperature between the setpoint and the actual process temperature. Offset is the error in the process variable that is typical of proportional-only control.

**On/Off Control**
A method of control that turns the output full on until setpoint is reached, and then off until the process error exceeds the hysteresis.

**Open Loop**
A control system with no sensory feedback.

**Operator Menus**
The menus accessible from the front panel of a controller. These menus allow operators to set or change various control actions or features.

**Optical Isolation**
Two electronic networks that are connected through an LED (Light Emitting Diode) and a photoelectric receiver. There is no electrical continuity between the two networks.

**Output**
Control signal action in response to the difference between setpoint and process variable.

**Output Type**
The form of PID control output, such as Time Proportioning, Distributed Zero Crossing, SDAC, or Analog. Also the description of the electrical hardware that makes up the output.

**Overshoot**
The amount by which a process variable exceeds the setpoint before it stabilizes.

**Panel Lock**
A feature that prevents operation of the front panel by unauthorized people.

**PID**
Proportional, Integral, Derivative. A control mode with three functions: Proportional action dampens the system response, Integral corrects for droops, and Derivative prevents overshoot and undershoot.

**Polarity**
The electrical quality of having two opposite poles, one positive and one negative. Polarity determines the direction in which a current tends to flow.

**Process Variable**
The parameter that is controlled or measured. Typical examples are temperature, relative humidity, pressure, flow, fluid level, events, etc. The high process variable is the highest value of the process range, expressed in engineering units. The low process variable is the lowest value of the process range.

**Proportional (P)**
Output effort proportional to the error from setpoint. For example, if the proportional band is 20° and the process is 10° below the setpoint, the heat proportioned effort is 50%. The lower the PB value, the higher the gain.

**Proportional Band (PB)**
A range in which the proportioning function of the control is active. Expressed in units, degrees or percent of span. See PID.

**Proportional Control**
A control using only the P (proportional) value of PID control.

**Pulse Input**
Digital pulse signals from devices, such as optical encoders.
R

Ramp
A programmed increase in the temperature of a setpoint system.

Range
The area between two limits in which a quantity or value is measured. It is usually described in terms of lower and upper limits.

Recipe
See Job.

Reflection Compensation Mode
A control feature that automatically corrects the reading from a sensor.

Relay
A switching device.

Electromechanical Relay — A power switching device that completes or interrupts a circuit by physically moving electrical contacts into contact with each other. Not recommended for PID control.

Solid State Relay (SSR) — A switching device with no moving parts that completes or interrupts a circuit electrically.

Reset
Control action that automatically eliminates offset or droop between setpoint and actual process temperature.
See also Integral.

Automatic Reset — The integral function of a PI or PID temperature controller that adjusts the process temperature to the setpoint after the system stabilizes. The inverse of integral.

Resistance
Opposition to the flow of electric current, measured in ohms.

Resistance Temperature Detector (RTD)
A sensor that uses the resistance temperature characteristic to measure temperature. There are two basic types of RTDs: the wire RTD, which is usually made of platinum, and the thermistor which is made of a semiconductor material. The wire RTD is a positive temperature coefficient sensor only, while the thermistor can have either a negative or positive temperature coefficient.

Reverse Action
An output control action in which an increase in the process variable causes a decrease in the output. Heating applications usually use reverse action.

RTD
See Resistance Temperature Detector.

Serial Communications
A method of transmitting information between devices by sending all bits serially over a single communication channel.

RS-232—An Electronics Industries of America (EIA) standard for interface between data terminal equipment and data communications equipment for serial binary data interchange. This is usually for communications over a short distance (50 feet or less) and to a single device.

RS-485—An Electronics Industries of America (EIA) standard for electrical characteristics of generators and receivers for use in balanced digital multipoint systems. This is usually used to communicate with multiple devices over a common cable or where distances over 50 feet are required.

Setpoint (SP)
The desired value programmed into a controller. For example, the temperature at which a system is to be maintained.

Shield
A metallic foil or braided wire layer surrounding conductors that is designed to prevent electrostatic or electromagnetic interference from external sources.

Signal
Any electrical transmittance that conveys information.
Solid State Relay (SSR)
See Relay, Solid State.

Span
The difference between the lower and upper limits of a range expressed in the same units as the range.

Spread
In heat/cool applications, the +/- difference between heat and cool. Also known as process deadband.

See deadband.

Stability
The ability of a device to maintain a constant output with the application of a constant input.

T

T/C Extension Wire
A grade of wire used between the measuring junction and the reference junction of a thermocouple. Extension wire and thermocouple wire have similar properties, but extension wire is less costly.

TD (Timed Derivative)
The derivative function.

Thermistor
A temperature-sensing device made of semiconductor material that exhibits a large change in resistance for a small change in temperature. Thermistors usually have negative temperature coefficients, although they are also available with positive temperature coefficients.

Thermocouple (T/C)
A temperature sensing device made by joining two dissimilar metals. This junction produces an electrical voltage in proportion to the difference in temperature between the hot junction (sensing junction) and the lead wire connection to the instrument (cold junction).

Transmitter
A device that transmits temperature data from either a thermocouple or RTD by way of a two-wire loop. The loop has an external power supply. The transmitter acts as a variable resistor with respect to its input signal. Transmitters are desirable when long lead or extension wires produce unacceptable signal degradation.

U

Upscale Break Protection
A form of break detection for burned-out thermocouples. Signals the operator that the thermocouple has burned out.

Undershoot
The amount by which a process variable falls below the setpoint before it stabilizes.

V

Volt (V)
The unit of measure for electrical potential, voltage or electromotive force (EMF).
See Voltage.

Voltage (V)
The difference in electrical potential between two points in a circuit. It’s the push or pressure behind current flow through a circuit. One volt (V) is the difference in potential required to move one coulomb of charge between two points in a circuit, consuming one joule of energy. In other words, one volt (V) is equal to one ampere of current (I) flowing through one ohm of resistance (R), or V = IR.

Z

Zero Cross
A condition that provides output switching only at or near the zero-voltage crossing points of the ac sine wave.
Index

A
Add Graphic Screen 10-7
Alarm Button/Indicator 2-1, 2-2
Alarm Screen 11-1, 11-2
Alarm Message 11-2
Alarm Symbol 11-3
Alarm Type 11-2
Channel Name 11-2
Clear View 11-3
Date/Time 11-2
displaying automatically 4-5
Group Name 11-2
printing 11-3
Alarm Symbols 11-3
Alarm Types 11-3
Alarms
acknowledging 11-4
setting 5-6
Allow Channel Grouping check box 1-6, 5-3
Allow Windows Screen Saver 4-5
AnaMator A-1
Animation Setup Screen A-2
Frame Setup Screen A-4
controls A-5
with Frame Window A-5
Setup Screen A-2
with Sequence Running Window A-7
Status Bar A-4, A-6
animation object A-1
animation properties 10-17
Animation Properties Table 10-17
animation restrictions A-1
Animation Setup Screen A-2
animations
assigning bitmap files frames A-4
automatic repeat A-4
creating A-1, A-4
defining number of frames A-3
defining number of sequences A-3
defining update speed A-3
displaying memory used A-3
editing A-3
opening A-2
opening existing A-2
playing back A-6
removing A-6
saving A-6
setting up A-3
Audible Alarm, computer 4-5
Auto Alarm View 4-5, 11-1
Automatic ModBus Address Setup 1-8
Axis property page 7-9

B
Background property page 7-18
Bar Graph Display 8-2
Begin Report fields 3-2

C
Calendar (option on Recipe menu) 6-4
Calendar Events Screen 6-4
calendar events, suspending 6-6
caption 2-1, 2-2
Channel and Digital IO Names Screen 1-9
Channel Grouping 1-6
setup screen 1-6
Channel Number 5-2
Channel Parameters C-6
(Channel Setup menu option) 5-1
copying 5-3
selecting input 5-4
selecting output 5-5
setting 5-1
Channel Setup
Alarm Tab 5-6, 5-7
Control Tab 5-5, 5-6
Input Tab 5-4
menu 2-3, 5-1
Other Tab 5-7
Output Tab 5-5
Channel Setup Screen 5-1
Add and Remove Buttons 1-7
Available Panel 1-7
Group Parameters 1-7
Channel Setup Tabs 5-4
Channel summary 5-2
Channels
copying 5-3
selecting 5-2
selecting for setup 5-2
viewing 8-1
Com Diags (System menu option) 4-10
Communicating Controller 2-1, 2-2
Communication Diagnostics Screen 4-10
Communication Disabled Indicator 4-10
Communication Enabled Indicator 4-9
communication errors, displaying 4-10
Communication Status Indicator 2-1, 2-2
Communications, enabling and disabling 4-9
Computer Audible Alarm 4-5
Configuration, controller 1-4
Configuration, controller, setting ModBus protocol 1-4
Configure (System menu option) 4-10
Configure program, launching 4-10

AnaWin User’s Guide Index-1
Index

Configuring Communications Options 1-8
Control Mode 5-3
selecting 5-5
Controller communication (comm) status 1-5
Controller Setup Screen 1-3, 1-4
Copy 5-3
Copy to A
(Logs menu option) 9-4
Current Group 2-1, 2-2
Custom Overview Screen 10-1
(View menu option) 8-6
adding graphics 10-7
animation properties 10-16
creating new 10-3
digital I/O image properties 10-13
digital I/O text properties 10-11
displaying from thumbnail 8-5
field properties 10-9
graphic properties 10-14
label properties 10-7
opening existing 10-3
sample 8-6, 10-2
screen objects 10-4
selecting 10-4
setting form properties 10-6
user variable properties 10-15
zoom properties 10-18
Custom View Screen 10-3
displaying 10-3
customizable features 4-1
customizing
displayed names 1-8
parameter names 1-9

D
Data Log Settings Screen 3-4
Data Log Setup 3-1
(File menu option) 3-4
Data logging
selecting channels to log 3-4
setting logging interval 3-4
setting up automatic 3-4
starting 3-5
status 3-4
stopping 3-5
Data Set to View 7-21
Data Storage Settings Screen 7-22
displaying 7-21
data storage, indefinite 7-22
default password 4-5
Default Recipe Comment 4-8
Derivative 5-6
design mode 10-3
exiting 10-4
Detect button 1-5
Developer menu 2-3, 10-1
Developer Program, using 10-1
Digital I/O Graphic Properties Table 10-13
Digital I/O image properties 10-13
Digital I/O Screen 8-4
displaying 8-4
Digital I/O text properties 10-11
Disk Space Analysis 7-22
disk space, displaying 7-22
Done button 3-5

E
Enable Floppy Backup 6-3
Enable Passwords 4-5
End Report fields 3-2
Event Number Sequences 9-3
event types 9-2
Event Window 5-14
displaying 5-14
Events
alarm 9-3
defining 5-14
system 9-3
user 9-3
Export Data Now 3-4
Export Database 3-1
(File menu option) 3-1
Export file 3-3
file name 3-3
Export Settings Screen 3-1
Exporting data 3-1
Exporting process data 3-1

F
field properties 10-9
Field Properties Table 10-9
File menu 2-3, 3-1
Fonts property page 7-13
form properties 10-7
Form Properties Table 10-6
Formulas and User Defined Variables Screen 10-20
displaying 10-20

G
Gauge Display 8-2, 8-3
viewing 8-2
Gauge Display Editable Parameters 4-9, 8-4
Gauge Display Screen, specifying editable parameters 4-9
Global Parameters C-8
graphic properties 10-14
Graphic Properties Table 10-14

H
Help menu 2-3

I
In button 5-4
Installation 1-3
Installation and Setup 1-1
Integral 5-6

L
label properties 10-8

Index-2 AnaWin User's Guide
Label Properties Table 10-8
Last button 5-4
Last Recipe Downloaded 2-1, 2-2
launch actions, specifying 4-3
Level Passwords Panel 4-7
Location 5-9
Log file
  closing 9-4
  copying to disk 9-4
  name format 9-1
  printing 9-4
  removing 9-4
  sample 3-3, 9-2
  searching 9-4
  selecting 9-2
  selecting channels to export 3-3
  selecting name and location 3-3
  setting end point 3-2
  setting logging interval for 3-3
  setting start point 3-2
Log File Selection Screen 9-2
Logging interval 3-3, 3-4
Login (System menu option) 4-2
Login/Logout Buttons 2-1, 2-2
Logout (System menu option) 4-2
Logs menu 2-3, 9-1
loops, synchronizing 5-10

M
Main Menu 2-1, 2-2, 2-3
Markers property page 7-14
Maximize/Minimize buttons 2-3
Maximum Days Stored on Disk 7-22
menu tree, password protecting 4-6
Message box 2-1
Monitoring Configured Controllers 1-10
Monthly Calendar 6-6
  symbols 6-6

N
New (option on Recipe menu) 6-2
Normal Startup Panel 4-3
Normal Startup, specifying actions for 4-3
Now button 3-2
Number of Data Sets Displayed 7-21

O
OLE Server C-1
  constant values C-5
  exposed methods C-1
  features C-1
Online Help 2
Open (option on Recipe menu) 6-3
Open Animation Window A-3
Operator Select on Startup 4-3, 4-4
Out button 5-4
Over Limit Action 4-3, 4-4
  options 4-4
Overview Thumbnails Screen 8-5, 10-18
displaying 8-5, 10-18

P
Parameter Names Screen 1-8
Parts List 1-2
Password Level Required Panel 4-6
Password protection
  enabling 4-5
  setting by level 4-6
  setting by user 4-6, 4-7
Password Setup Screen 4-5
PID Filter 5-6
Plot Setup Screen 7-20
displaying 7-20
Power Fail Recovery 4-3
  specifying response to 4-3
  power percentages, changing 5-3
Preferences (System menu option) 4-2
Preferences Screen 4-2
Process 5-2
process variable, displaying 5-2
Profile
  assigning to loops 5-8
  creating new with default values 5-9
  defining 7-5
  definition 5-7
  displaying on graph 7-6
  editing 5-12
  recalling channels for 7-6
  removing from graph 7-6
  selecting location for download 5-9
Profile Channels to View Window 7-6
Profile Name 5-9
profile ready states, defining 5-15
Profile Recall Controls 7-6
profile recording
  starting 7-5
  stopping 7-5
Profile Recording Controls 7-5
profile view 5-12
Program startup changes, cancelling 4-4
Program startup options, saving 4-4
Prop Band 5-6

R
Ramp Soak Assignment Screen 5-8
Ramp Soak Edit Screen 5-12
displaying 5-12
Ramp Soak Option check box 1-5, 5-8
Ramp Soak profile status 5-11
Ramp Soak Ready State Screen 5-15
displaying 5-15
Ramp Soak Setup (Channel Setup menu option) 5-7
ramp, definition 5-7
ramp/soak features 5-8
Ramp/Soak status 5-3
  selecting 5-5
Read Parameters From Controller 4-3, 4-4
Real-time Plot Screen (on Channel Setup Screen) 5-1
Real-time Trend Plot (on Channel Setup Screen) 5-3
Recipe
  - creating 6-2
  - deleting 6-4
  - disabling downloads 4-9
  - downloading 6-4
  - management 6-1
  - opening existing 6-3
  - saving 6-3
  - scheduling for automatic download 6-4
recipe comment, editing default 4-8
Recipe Downloads, disabling 4-9
Recipe Editor Screen 6-2
  - printing 6-3
Recipe management 6-1
  - with channel grouping 6-2
Recipe menu 2-3, 6-1
Recipe Name 6-5
Recipe Spread Sheet 6-2
Recipe Start Date 6-5
Recipe Start Time 6-5
Recording Rate 7-22
reference loop
  - selecting 7-6
  - selecting velocity units for 7-6
  - setting offsets for 7-5
Reference Loop Setup Window 7-5
  - displaying 7-5
Remove (option on Recipe menu) 6-4

S
Save (option on Recipe menu) 6-3
Scale button 5-4
Scheduled Recipes panel 6-6
Screen Conventions 2-1
Screen Objects 10-4
  - adding 10-5
  - copying 10-5
  - deleting 10-5
  - modifying 10-5
  - moving 10-5
  - setting Object Properties 10-6
Segment
  - jumping to new 5-11
  - modifying time remaining 5-11
Segment information, defining 5-13
Select File 3-3
Select Profile Channels to View window, displaying 7-6
Selecting Channels to Export 3-3
Selecting Channels to Log 3-4
Send Parameters to Controller 4-3, 4-4
sensor location offsets 7-6
sensor type, selecting 5-4
Setpoint, entering 5-2
Setting startup options 4-2
Setting System Parameters 4-1
Setting up Passwords 4-5
Slope 7-7
  - specifying boundaries 7-4
Slope Controls 7-4
Slope Spreadsheet 7-7
  - displaying 7-7
  - keeping displayed 7-8
Snapshot 4-10
  - restoring 4-11
  - saving 4-11
soak, definition 5-7
Special Ramp-Soak Functions 5-9
Special Ramp-Soak Functions Window 5-10
Spreadsheet Overview Screen 8-2
  - displaying 8-1
  - Process Variable (PV) column 8-2
  - spreadsheet view 1-6
Start button 3-5
Stop button 3-5
Suspend Calendar Events 6-6
Synchronizing loops 5-10
System Alarms 11-1
System Block Diagram 1-2
System menu 2-3, 4-1
System parameters, setting 4-1
System Property Page 7-19
System requirements
  - hardware 1-1
  - software 1-1
System safety 1-2
System setup 1-3

T
Technical Support 2
Text Properties Table 10-11
Threshold Controls 7-5
Threshold levels, setting 7-5
Thresholds
  - computing duration 7-5
  - displaying on graph 7-5
  - entering values 7-5
Threshold Controls 7-5
  - displaying on graph 7-5
  - entering values 7-5
Thumbnail Hot Key / Position Window 10-19
Time Range 7-21
Titles Property Page 7-9
Titles, not displaying 7-9
Trend 7-8
Trend Extras Window 7-4
  - displaying 7-4
Trend Plot (Trend Plot menu option) 7-1
Trend Plot menu 2-3, 7-1
Trend Plot Screen 7-2
  - Adjust buttons 7-2
  - Last button 7-3
  - Now button 7-3
  - Scale button 7-3
configuring data sets 7-21
  - defining number of data sets 7-21
  - displaying 7-1
icons
  - Axis icon 7-9
  - Background icon 7-18
  - Markers icon 7-14
Index

Titles icon 7-8
Plot Legend 7-2
resolution gauges 7-3
setting graph limits 7-21
setting number of days for historical plotting 7-22
setting time range 7-21
setting up data sets for display 7-20
specifying data recording rate 7-22
Toolbar 7-8
Trend Plot Settings (Trend Plot menu option) 7-20
Trend Plot Storage (Trend Plot menu option) 7-21
Trends Property Page 7-16
Trigger Window, displaying 5-14
Triggers 5-8
defining 5-14

U
Under Limit Action 4-3, 4-4
options 4-4
User Information Panel 4-7
User Login Screen 4-2
User password, changing 4-8
user variable properties 10-15
User Variable Properties Table 10-15
User Variable Spreadsheet 10-22
User Variables 10-20
assigning entries to cells 10-21
available functions B-2
available operators B-1
Controller Value 10-21
creating 10-22
Data Entry Controls 10-20
Formula 10-20
Number 10-20
selecting type of controller data 10-21
User-defined variable, in animation objects A-1
Users
adding 4-8
deleting 4-8

V
View (Logs) (Logs menu option) 9-1
View Manager 10-18
View menu 2-3, 8-1

W
Windows screen saver, enabling 4-5

Z
zoom properties 10-18
Zoom Properties Table 10-18
Index